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KIRISH 

 

―Biz yoshlarga doir davlat siyosatini hech og‘ishmasdan,qat‘iyat bilan davom 

ettiramiz. Nafaqat davom ettiramiz, balki bu siyosatni eng ustuvor vazifamiz 

sifatida butun zamon talab qilayotgan yuksak darajaga ko‘taramiz.‖ 

Sh. M. Mirziyoyev 

 

2017 yil 20 aprelda O‗zbekiston Respublikasi Prezidentining ―Oliy ta‘lim 

tizimini yanada rivojlantirish chora-tadbirlari to‗g‗risida‖gi qarori qabul qilindi. 

Ushbu qaror oliy ta‘lim tizimini tubdan takomillashtirish, mamlakatimizni 

ijtimoiy-iqtisodiy rivojlantirish borasidagi ustuvor vazifalarga mos holda, kadrlar 

tayyorlashning ma‘no-mazmunini tubdan qayta ko‗rib chiqish, xalqaro standartlar 

darajasida oliy malakali mutaxassislar tayyorlash uchun zarur sharoitlar yaratish 

maqsadiga yo‗naltirilgan. 

Qarorga ko‗ra, oliy ta‘lim tizimini kelgusida kompleks rivojlantirishning 

muhim vazifalari belgilab berildi. Qarorda belgilangan vazifalarning samarali 

yechimini to‗liq ta‘minlash maqsadida oliy ta‘lim darajasini sifat jihatdan oshirish 

va tubdan takomillashtirish, oliy ta‘lim muassasalari moddiy-texnika bazasini 

mustahkamlash va modernizatsiya qilish, ularni zamonaviy o‗quv-ilmiy 

laboratoriyalari, axborot-kommunikatsiya texnologiyalar bilan jihozlash maqsadida 

Oliy ta‘lim tizimini 2017-2021 yillarga mo‗ljallangan kompleks rivojlantirish 

dasturi tasdiqlandi. 

Dasturga muvofiq, 2017-2021 yillarda 48 ta oliy ta‘im muassasasida jami 

180 ta o‗quv, ilmiy-laboratoriya binosi, sport inshootlari va ijtimoiy-muhandislik 

infratuzilmalari ob‘ektlarida qurilish, rekonstruksiya va kapital ta‘mirlash ishlari 

olib boriladi. Shuningdek, 53 ta oliy ta‘lim muassasasida 400 ta o‗quv 

laboratoriyasi bosqichma-bosqich eng zamonaviy o‗quv-laboratoriya uskunalari 

bilan jihozlanadi,7 ta oliy ta‘lim muassasasida barcha oliy ta‘lim muassasalari 

o‗zaro hamkorlikda foydalanadigan ilmiy laboratoriyalar tashkil etiladi. 
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Qarorning yana bir muhim jihati shundaki, mamlakatimiz Prezidenti 

tomonidan har bir oliy ta‘lim muassasasi bo‗yicha konkret parametr va 

ko‗rsatkichlarni o‗z ichiga olgan manzilli rivojlantirish dasturilari tasdiqlandi. 

Mazkur dasturda asosan mamlakatimizning har bir oliy ta‘lim muassasasi 

bilan, xususan, AQSh, Buyuk Britaniya. Fransiya, Italiya, Niderlandiya, Rossiya, 

Yaponiya, Janubiy Koriya, Xitoy va shu kabi boshqa davlatlarning yetakchi ilmiy-

ta‘lim muasasasalari bilan hamkorlik aloqalarining o‗rnatilgani o‗ta muhim 

ahamiyat kasb etadi. Shu asosda har yili 350 nafardan ortiq xorijlik yuqori 

malakali pedogog va olimlarning mamlakatimiz oliy o‗quv yurtlariga o‗quv 

jarayoniga jalb etilishi ko‗zda tutilmoqda. 

Shu o‗rinda aytish lozimki, Oliy ta‘lim tizimini 2017-2021 yillarga 

mo‗ljallangan kompelks rivojlantirish dasturini amalga oshirish uchun 

yo‗naltiriladigan moliyaviy mablag‗lar 1,7 trillion so‗mdan ziyod bo‗lib, ulardan 

1,2 trillion so‗mi o‗quv-laboratoriya binolari, sport zallari va talabalar 

turarjoylarini rekonsturksiya qilish va kapital ta‘mirlashga, 500 milliard so‗mdan 

ortiq mablag‗ esa o‗quv-laboratoriya uskunalari, mebel va inventar bilan 

ta‘minlash, umumiy tartibda foydalanishga mo‗ljallangan, barcha ta‘lim 

musassasalariga xizmat ko‗rsatadigan laboratoriya kompelkslarini tashkil etish 

hamda axborot-kommunikatsiya texnologiyalarini rivojlantirishga sarflanadi. [1] 

Mavzuning dolzarbligi. Keyingi yillarda amaliy dasturchilarga juda ko‘p 

integratsion dastur tuzish muhitlari taklif etilmoqda. Bu muhitlar u yoki bu 

imkoniyatlari bilan bir–biridan farq qiladi. Shu bilan birgalikda grafik interfeysga 

ega bo’lgan dasturlar soni ham kundan-kunga ortib bormoqda.Nashriyot uchun 

foydalaniladigan dasturlar turkumiga kiruvchi  Adobe InDesign dasturi shular 

jumlasiga kiradi. Adobe InDesign dasturida ishlash bo’yicha  o’quv uslubiy 

qo’llanma o’zbek tilida mavjud emasligi mavzuning dolzarblidir. 

Bitiruv malakaviy ishimizning maqsad va vazifalari. Adobe InDesign 

dasturining barcha imkoniyatlari bilan yaqindan tanishish va uning boshqa grafik 

interfeysga ega dasturlar bilan umumlashtiruvchi va farqli tomonlarini solishtirib 
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o’rganish. Adobe InDesign dasturi orqali jurnallarga muqova tayyorlashni 

o’rganish. 

Bitiruv malakaviy ishimizning o’rganilganlik darajasi.  Adobe InDesign 

dasturining interfeysi bilan to’liq tanishib chiqilgan. Unda bajarilgan amaliy 

ishlarning bir qanchasi o’rganib chiqilgan va o’quv uslubiy qo’llanma tayorlangan. 

Bitiruv malakaviy ishimizning predmeti. Adobe InDesign dasturi, matnlar, 

ranglar,ko’p sahifali hujjatlar , stillar yaratish,kitoblar va kutubxonalar bilan 

ishlovchi komponentlar. 

 Bitiruv malakaviy ishimizning obyekti.  Adobe InDesign dasturi, unda kitob 

va jurnallar yaratish uchun foydalaniladigan buyruqlar. 

Bitiruv malakaviy ishimizning ilmiy farazi. Adobe InDesign dasturida ishlash 

bo’yicha o’quv uslubiy qo’llanma yaratish orqali ta’lim jarayonida bu dasturning 

imkoniyatlarini ochib berish.Ta’lim  jarayonini yanada yuksaltirish, yangi usul va 

vositalarini yaratish, o’quv jarayonining samarodorligini oshirish.   

Bitiruv malakaviy ishimizning yangiligi. Bugungi kunga qadar Adobe 

InDesign dasturida o’zbek tilidagi ma’lumotlar yetarli  darajada emas. Bu dastur 

bo’yicha o’zbek tilida o’quv uslubiy qo’llanma yaratish va o’quv jarayoniga qo’llash 

bitiruv  malakaviy ishimning yangiligi hisoblanadi. 

Bitiruv malakaviy ishimizning amaliy ahamiyati shundan iboratki, bu o`quv 

uslubiy qo’llanma amaliyotda qo’llanilsa, nashriyot tizimida jurnal kitoblarning yuz 

qismini tayyorlash jarayoni ancha oson kechadi. 

 Bitiruv malakaviy ishimizning metodologik asosini  uning tarkibiy qismi, 

undagi o’quv va didaktik vositalarning jamlanganligidir. Bu  o’quv uslubiy 

qo’llanma ta’lim jarayonini samarali tashkil etishda ham amaliy ahamiyat kasb 

etadi. 
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Bitiruv malakaviy ishimizning metodlari. Adobe InDesign dasturida ishlash 

bo’yicha o’quv uslubiy qo’llanma yaratish va undan nashriyot tizimida keng 

ko’lamda mumkin. 

Bitiruv malakaviy ishining tarkibi va hajmi quyidagicha. Kirish, 2 ta bob, har bir 

bobning qisqacha xulosasi, adabiyotlar ro’yxati, xotimadan iborat bo’lib jami 90 

betga bayon qilingan. I bobda Adobe InDesign dasturi bilan tanishish, obyektlar, 

geometrik figuralar, matnlar bilan ishlash bo’yicha ma’lumotlar keltirilgan.  

II bobda ko’p sahifali hujjat, stillar yaratish va undan foydalanish, kitoblar va 

kutubxonalar haqida ma’lumotlar keltirilgan.  

Kirish qismi 4 betdan iborat , tushuntirish qismi 80 betdan iborat. Bitiruv 

malakaviy ishida 9 ta adabiyotdan foydalanildi. 
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I BOB.  ABOBE INDESIGN MUHITIDA BILAN TANISHISH 

1.1. Abobe Indesign dasturi bilan tanishish 

Dasturni ishga tushiring (Boshlash> Dasturlar> Adobe InDesign CS5), 

hujjatni yaratilganda, oynani ko'rib chiqing (1.1-rasm). Dastur oynasi Adobe 

paketlar uchun an'anaviy bo'lib, panel tuzilishiga ega, ya'ni panellar yoki palitradan 

(tasvir vositalarian) iborat. 

 

1.1.1 – rasm. Dastur oynasi. 

Asosiy(bosh) menyu dastur bilan ishlash uchun zarur bo'lgan barcha 

buyruqlarni o'z ichiga oladi va an'anaviy tarzda tashkil etilgan: 

 Fayl (Fayl) - fayllarni boshqarish, import qilish, eksport qilish va chop etish; 

 Edit - hujjatga kiritilgan umumiy o'zgarishlar bilan bog'liq har bir vazifa; 

 dastur parametrlarini o'zgartirish buyrug'i ham shu erda joylashgan; 

 Layout (Layout) - sahifani belgilash, maket bo‘yicha ko‘chish, nashrning 

(publikatsiyaning) umumiy elementlarini boshqarish; 

 Objeckt (Ob'ekt) - ob'ektlarni boshqarish (matn qismlari, rasmlar, shakllar va 

h.k.); 

 Table (jadvallar) - yaratish, formatlash va tahrir qilish bilan bog'liq har bir 

vazifa; 

 View (Ko‘rinish) – maketning ekrandagi ko‘rinishini sozlash; 

 Window (Oyna) - dastur oynasini boshqarish, ayniqsa ekran va 

palitralarning joylashuvi; 

 Help (yordam) – ma‘lumotnomani (yordamchi ma‘lumotlarni) chaqirish. 
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Ilovalar paneli asosiy menyuning tepasida joylashgan va ba'zi bir oynalarning 

sozlamalariga kirishni tezkorlik bilan ta'minlaydi (masalan, asosiy ekran 

sozlamalari, hujjatlarni oynaga joylashtirish va ish joyining asosiy 

konfiguratsiyalari); 

Bu yerdan, Adobe Bridge dasturini tez chaqirish mumkin, qaysisi Adobening turli 

dasturlarda yaratilgan tasvirlarni ko'rish, almashtirish va sinxronlashtirishni 

ta‘minlaydi. 

Asboblar paneli dasturda ishlatilgan barcha asosiy vositalarni birlashtiradi. 

Boshqarish (nazorat) paneli har qanday ob'ekt bilan bog'liq asosiy 

parametrlarni o'z ichiga oladi: hajmi, joyi, rangi, va hokazo; boshqaruv paneli 

maydonlari turli asboblar uchun bir oz farqlanadi. 

Palitralar dasturning buyruqlar va vositalarining asosiy ma'lumotlariga, 

batafsil sozlamalariga tezkor kirishni ta'minlaydi. 

Hujjat oynasi hujjatning ish maydoni va u haqida asosiy ma'lumotlarni o'z 

ichiga oladi. 

Ish maydoni va sahifalar –  to'g'ridan-to'g'ri dastur oynasining bir qismidir 

va maket ustida ishlash uchun mo'ljallangan, chunki publikatsiyani shaklantirish 

uchun aynan shu erda biz barcha matnlarni, rasmlarni, multimedia materiallarini va 

boshqalarni joylashtiramiz. [2] 

Dasturning ish sohasi (Workspase). Tahrirlash, sozlash, saqlash 

Dastur oynasining barcha elementlari "Ish maydoni" deb ataladi. Ish 

maydonini yechlayotgan masalaga qarab, o‘zgartirish mumkin.  Masalan, ekranda 

faqat tez-tez ishlatib turadigan palitralarni saqlash mumkin: ularning joylarini 

almashtirish, ekrandan yig‘ish, kichiraytirish yoki butun ekranda ko'rsatish, 

hujjatlar oynalarning nisbiy pozitsiyasini o'zgartirish va hokazo. Siz o‘zingiz uchun 

moslashtirilgan ish maydonni saqlang va kerak bo‘lganda uni ekranga chakiring. 

O‘z ish maydongizni saqlash uchun  quyidagi buyruqni bajaring  

Window>Workspace> New Workspace (Oyna> Ish maydoni> Yangi ish 

maydoni) nomlang va sozlamalarini belgilang (panellarning faqat joyini saqlash 
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kerakmi yoki asosiy menyuning qo'shimcha parametrlarini ham saqlash). Odatda 

taklif etiladi ―all‖ (hammasini) saqlash (1.2-rasm). 

 

1.1.2 – rasm. Ish sohasini saqlash. 

Ish maydonining tayyor konfiguratsiyasini tanlashingiz mumkin: 

Typography (Matn bilan ishlash), Printing and Proofing (bosmaga 

tayyorlash) 

va hokazo. 

Bizning o'quv vazifalarimiz uchun biz Advanced (kengaytirilgan) 

konfiguratsiyani ishlatamiz. Agar ba'zi bir standart sozlamalarni qayta tiklash 

kerak bo'lsa, bunda quyidagi ketme-ketlikni bajaring:  

Window>Workspace>Reset Advanced  (Oyna> Ish maydoni> Tanlangan ish 

maidonini tiklash). 

Oyna>Ish maydoni> ni tanlab, Maxsus tanlangan ish maydonni o'chirishingiz 

mumkin, unda  Window>Workspace>Delete Workspace (Oyna > Ish maydoni> 

Ish maydonini o‘chirish) ketma-ketlikni bajaring. 

Palitralar bilan ishlash 

Palitralar asosiy asboblarga va sozlamalarga tez kirishni ta‘minlaydi: 

Odatda palitralar mavzular asosida  guruhlarga  to'planadi.  

Masalan: Stroke (Satr)/Swathes (Namunalar) / Gradient (Gradient).  
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Guruhlar ekranning o'ng tomonida bir stekga to‘plangan bo‘lib, asboblar 

panelniga qarama-qarshi joylashgan. Ush bu stek interfeys elementlardan iborat 

bo‘lgan ―ramkani‖ yakunlaydi (o‘ng tomondagi asboblar paneli, boshqaruv 

paneli va bosh menyu o'ngdagi palitraning yuqorisida yoki pastiga joylashgan). 

Bunisi interfeysning kerakli elementini topishini osonlashtiradi va u egallagan 

maydonning hajmini kamaytiradi. 

Palitralarning standart majmui tanlangan ish maydoniga qarab o'zgaradi 

(1.3-rasm). Har bir ish maydoni, standart yoki maxsus, nafaqat ko'rsatilgan 

palitralar ro'yxatini o‘z ichga oladi, hamda ularning joylashuvini va holatini 

ko‘rsatadi.  

 

1.1.3 – rasm. Palitralarni standart joylashuvi 

Barcha palitralar guruhdan va steklardan ajralishi mumkin, ularni yig‘ish va 

ochish, boshqa guruhlarga qo'shish yoki alohida dastur oynasiga joylashtirish 

mumkin. 

Joyni tejash uchun hozirda ishlatilmaydigan palitralarni yig‘ib qoyish 

mumkin. Buni amalga oshirish uchun Expand Panels (Palitralarni kengaytirish) 

ikkilangan ko‘rsatgich har bir palitraning yuqori o'ng burchagida joylashgan (1.5-

rasm). 
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1.1.4-rasm. Stekdagi ochilgan holdagi palitra 

Uskunalar paneli 

Asboblar panelida (1.1.5-rasm) dasturda ishlash uchun zarur bo‘lgan barcha 

asosiy vositalar joylashgan. Palitralar kabi ular mavzular bo‘yicha guruhlangan: 

alohida – ob‘ektlarni tanlash vositalari, alohida -  matn bilan ishlash va rasm 

chizish uchun va oxirgisi – bu xizmatchi guruh: navigatsiya, ko‘rinish masshtabi 

va atributlarni tezkor nushalash. 

 

1.1.5 – rasm. Uskunalar paneli haqida batafsil ma`lumot 

Odatda asboblar paneli dastur oynasining chap tomonida joylashgan. 

Panelning yuqori qismidagi ikkilangan ko‘rsatgich joylashgan, uning yordamida 

asboblarni ochib, ikkita qatorda terish mumkin  (nisbatan kichik ekranlar uchun 

qulay, masalan, noutbuk bilan ishlaganda) yoki birta qatorda ko‘rsatish mumkin, 

bunda oynada ish maydoni kattalashadi  

Agar kerak bo'lsa, ekranda asboblar panelini ko'chirish mumkin, sarlavha  

qismidagi juft nuqtali chiziqni ushlab panelni ko‘chiring. Panelning ko'chishi va 
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joyiga qaytib kelishi, barcha boshqa plitralar bilan bir xil. Palitraning "suzuvchi" 

holatida ikkitalik ko‘rsatgich bosilsa, bunda asboblar paneli gorizontal holatga 

keladi (rasm 1.1.6).  

 

1.1.6 – rasm. Gorizontal holatda 

Kursorni asbob belgisi ustiga joylashtirsangiz yordamchi so‘zlar(podskazka) 

paydo bo'ladi: asbob nomlari va uni chaqirish uchun klaviatura tugmachasi 

ko‘rsatiladi (1.1.7-rasm).  

 

 1.1.7 – rasm. Uskunalar panelida yordamchi so`z (podskazka).  

E‘tibor bering, ba'zi tugmachalarning pastki qismida kichkina qora 

uchburchak joylashgan. Bu degani, bu tugma ostida bir nechta uskunalar mavjud. 

Yashirilgan elementlarni ko‘rsatish uchun, <Alt> tugmachasini bosib turib, 

tugmani bir necha marta bosish kerak yoki sichqoncha tugmasini bosib ushlab 

turing,  asboblar ro'yxati ochiladi, undan keraklisini tanlang. Yangi uskunani 

tanlagancha, tanlagan uskuna ko‘rsatilib turadi. 

Nazorat paneli (Boshqaruv palitrasi) 

 Nazorat paneli (Window > Control (Oyna > Nazorat paneli)) asosiy 

sozlamalarga va buyrqlarga tezkor ruxsatni beradi, qaysilari alohida ob‘ekt bilan 

bog‘langan bo‘ladi. Tanlangan asbobga qarab, panel umumiy sozlamalarni va 

asosiy transformatsiyalarni (o‘zgarishlarni) yoki Текст- asbobi uchun 

mo‘ljallangan, matnni formatlash uchun buyruqlarni o‘z ichiga oladi (1.1.8, 1.1.9-

rasm). 

 

1.1.8 – rasm. Selection Tool uskunalar panelining boshqaruv paneli 
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1.1.9 – rasm. Text Tool uskunalar panelining boshqaruv paneli 

 Odatda panel oynaning teppasida joylashadi  (Dock at Top), ammo uni 

oynaning pastiga ham qo‘chirish mumkin (Dock at Bottom) yoki panelni 

―suzuvchi‖ (Make Floating) ham qilish mumkin, bunda kontekst menyuning 

muvofiq buyruqlari ishlatiladi (1.1.10-rasm). 

 1.1.10-rasm. Boshqaruv panelini kontekst menyusi 

Hujjatni yaratish va  sozlash. 

Hozirgacha, dasturning  turli  vositalarini ko‘rib chiqqach, biz avval tuzilgan 

hujjatlarni ochib ulardan  foydalandik. Endi o‘z hujjatingizni qanday yaratishni 

ko‘rib chiqamiz. 

Yangi fayl, odatdagidek, File>New (Fayl>Yaratish) (<Ctrl>+<N>) buyrug‘i 

bilan yaratiladi. Hujjat yaratish muloqot oynasi ochiladi. (3.7-rasm)  

 

1.1.11-rasm. Hujjat yaratish dialogi. 



14 
 

Hujjatni yaratishda e‘tibor berishingiz kerak bo‘lgan asosiy maydonlar va 

parametrlar quyidagilardir:  

 Document  Preset (Hujjatni avvaldan sozlash) –  maydon sizga har safar 

oldindan yaratilgan va saqlangan, ularni qayta tiklanmasdan, bir qator 

parametrlardan foydalanishga imkon beradi; 

 Intent (Tayinlash) - biz bu yerda bosib chiqarish turini tanlaymiz: bosib 

chiqarish (Print) yoki  elektron (umumiy-Web); 

 Number of Pages (Sahifalar soni) - hujjatning sahifalar istalgan sonini 

belgilaydigan maydon. Avvaliga 3 belgilamiz va ish jarayonida ularni 

qo‘shishingiz  yoki o‘chirishingiz  mumkin; 

 Facing Pages (Ichki betlarni ko‘rsatish) - hujjatning sahifalarini (kitoblarda 

bo‘lgani singari) juft-juftlar bilan tartibga solish uchun ruxsat. Bayroqcha  

o‘chirigan bo‘lsa hujjatning sahifalari  ekranda birma-bir ko‘rsatiladi;  

 Master Text Frame (Shablondagi  matnning freymi) – matn uchu tayor joyni 

belgilaydi, bu maydon biz uchun juda foydali, matnni tezda ko‘p sahifada 

joylashtirish kerak bo‘lganda.  Bu sozlamani xozircha  yoqmaslik ham mumkin. 

Ochiladigan standart o’lchamlar ro‘yxat chop etiladigan kattaliklarni o‘z ichiga 

oladi. Widht (Kenglik) va Height (Balandlik) maydonlariga  ularning 

qiymatlari va tanlangan o‘lchov birliklari kiritiladi – odatda millimetrlar. Agar 

sizning nashringiz nostandart kattalikka ega bo‘lsa, siz faqatgina kenglik va 

balandlik  qiymatlarni kiritishingiz kerak va keyin sozlamalarni saqlab 

qo‘yishingiz kerak (Save Preset). 

 Orientation (Sahifalarning o‘rnashish tartibi) - hujjatlarning yo‘nalishini  

aniqlash:  vertikal yoki gorizontal (kitobli yoki albomli);   

 Columns  (Ustunlar) - ustunlar sonini sozlash (Number) va ular orasidagi 

masofa (Gutter); [3] 

 

 



15 
 

Izoh: Bu yerda o‘rnatilgan parametrlar hujjatlarning barcha sahifalariga 

qo‘llaniladi. Agar nashrda turli  ustunlar soni bilan tayorlansa, bu yerda bir soni 

qoldirilgani yaxshiroqdir, keyin siz turli  sahifalarni alohida so‘zlashingiz bo‘ladi. 

 Margins (Maydon kattaliklari) - nashrning barcha maydonlar o‘lchamlari. 

Agarda siz ichki betlarni ko‘rsatishga  ruxsat bersangiz, quyidagi sozlamalar 

amallanadi: Outside va Inside –  tashqi va ichki hoshiyalari, agarda hujjatda  

ichki betlar bo‘lmasa bo‘lmasa, unda Left va Right – o‘ng va chap so‘zlamalari 

ishlatiladi. 

Endi ko‘rib chqamiz, More Options (Qo‘shimcha sozlamalar) tugmasi  

nimani ochadi. Bu yerda biz o‘lchamni kiritish maydonini topamiz Bleed (Kesish 

uchun joy tashlash) (1.1.12-rasm).  

 

1.1.12-rasm. Bleed va Slug maydoni. 

Ular nima uchun kerak? Haqiqatdan ham, faylni tayyorlash jarayonida 

hujjatni kesish uchun qurilmaning xatosini hisobga olish kerak.  Odatda pichoq 2-3 

millimetrga siljishi mumkin, yoki chetga chiqib ketadi va shu erda oq, tekkis 

bo‘lmagan chiziq paydo bo‘ladi. Aynan bunday chiziqning paydo bo‘lishidan, 

kesish uchun tashlash sozlamasi bizlarni asraydi –  asl hajmini oshirish, har 

tomondan bir necha millimetrga (odatda 2-5 mm), kesish orqali ortiqchasi 

yo‘qoladi. Bunga kora sahifaning barcha  elementlari sahifa chekkasiga yopishgan 

(fotosuratlar, rangli plitalar) chegaradan chiqib, kengaytirish chegarasigacha borib 

yetadi (hujjat oynasida ko‘k chiziq bilan ko‘rsatilgan). Bleed doirasidan  tashqari 
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joylashgan barcha narsalar bosib chiqarilmaydi. Qirqib olinganidan so‘ng bosib 

chiqariladigan hujjatni ko‘rish uchun <W> tugmachasini bosib lozim.  

Slug parametri (Kesish uchun joy) - ichki tarkibiy qism bo‘lib, uning ichida 

maket tarkibidagi barcha muhim elementlar kirishi kerak –  matnlar, bezakli 

detallari, sahifalar soni. Hujjat uchun keng joylar maydonlar belgilansa, Slug 

parametri juda muhim emas va uni inkor qilish mumkin.  

OK ni bosib, hujjat oynasiga o‘tamiz. Yaratish oynasida ko‘rgan asosiy 

sozlamalarni o‘zgartirish zarur bo‘lsa, nima qilish kerak? 

Quyidagi sozlamalar bilan hujjat yaratish : 

-Intent=Print; 

-Size=A4; 

-Number of pages = 3;    

-Fasing Pages; 

-Number of Columns=2;  

-Gutter =5mm; 

-Margins Inside = Outside = Top = Bottom = 20mm; 

-Bleed = 5mm. 

Hujjatni yaratganingizdan so‘ng, muhokoma qilingan sozlamalar ikki 

guruhga bo‘linadi: birinchisi - muloqot oynasidagi Document Setup (Hujjat 

sozlamalari) Fayl menyusida  va ikkinchisi – Margins va Columns (Kolonkalar 

va maydonlar) oynasidagi Layout menyusida joylashgan. 

  File > Document Setup (Hujjat sozlamalari) oynasida, ustunlar sonini va 

maydonlarning o‘lchamidan tashqari barcha so‘zlamalar kirdi (3.9-rasm). Ish 

jarayonida  zarur bo‘lganda siz –  bizga tanish bo‘lgan More Options tugmasini 

bosib, qo‘shimcha joy qiymatini (Bleed) o‘zgartirishingiz mumkin.  
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1.1.13-rasm. Document Setup oynasi. 

Ustunlar soni va maydonlar kattaligi alohida ravishda sozlanadi (3.10-rasm). 

Ushbu parametrlarning qiymatiga kirish uchun Layout > Margins and Columns 

(Maket > Kolonkalar va maydonlar) buyrug‘i beriladi.   

 

1.1.14-rasm. Margins va Columns oynasi. 

Bu holda ushbu oynada kiritilgan qiymatlar faqat tanlangan sahifaga amal 

qilinadi. Bu ko‘p sahifali hujjat bilan ishlashda qiyinchiliklarni tug‘diradi: 

ustunlarni sozlash uchun har bir sahifada ushbu oynaga yana qaytasiz. Vazifani 

soddalashtira olasiz: biz bu haqida keyinroq muhokama qiladigan master- 

shablondan  foydalanishingiz kerak.[3]   

1.2. Obyektlar, geometrik figuralar. Transformatsiya 

Geometrik shakllar yaratish vositalari 

Geometrik shakllar har qanday maketning asosiy dizayn elementlari. Nashr 

butunlay suratlarsiz bo'lishi mumkin, juda ham sodda bo‘lishi mumkin, lekin hech 

bo'lmaganda sahifa raqami ustida bitta chiziq yoki ro‘yhat belgilarini aks ettirish, 

boshqa sodda belgilar qo‘yilgan bo‘lsa, bunda hjjat maketi darrov o‘zgaradi va o‘z 

ko‘rinishiga ega bo‘ladi.  Agar jurnallar, reklama, ma'lumotnoma materiallari 



18 
 

haqida gap yuritsak, bunda bilamiz ularda albatta har qanday rasmlar, shakllar, 

ramkalar ishlatiladi, chunki bunday dizayn e‘tiborni o‘ziga tortadi.  

InDesign CS5 turli xil geometrik vositalari bilan maqtana olmaydi, ammo bu 

tayyor shakllarni o'zgartirish uchun imkoniyatlari bilan boy. (2.1 -rasm). 

 

1.2.1 –rasm. Geometrik figura yaratish uskunalari 

"Taxminan" shakllar yaratish vositalari 

Rectangle  Tool  (To'rtburchak) (<M>) to'rtburchaklarni hosil qiladi; odatiy 

chizish usuli – taxmin qilingan ustgi chap burchagda sichqonchaning chap 

tugmasini bosib turib, diagonal bo‘yicha torting. Shakl kerakli kattalikga ega 

bo‘lgandan keyin, sichqonchani qoyib yuboring.  

Bunda <Shift> tugmachasini bosib tursangiz, kvadrat yaratiladi, <Alt> 

tugmachasini bosib tursangiz – chizish ob'ektning markazidan kelib chiqadi (2.2-

rasm). 

 

1.2.2-rasm. Geometrik uskunalar uchun klaviatur-modifikatsiyasi 

Agar rasm chizish jarayonida  tugmachalari bosib turilsa, 

bunda sichqoncha bilan ajratilgan maydon bir xil to'rtburchaklar bilan teng 

ravishda to'ldiriladi, ular ustun yoki satr bo‘lib joylashadi. Sahifani bezash uchun 

juda qulay imkoniyat, masalan, sahifaning butun kengligi yoki uzunligi bo'yicha 

"nuqta chiziq"ni chizish. 

To'rtburchak (Прямоугольник) vositasini tanlang va gorizontal 

cho'zilgan rasmni chizing; sichqoncha tugmachasini bosib turib, klaviaturadagi 
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 tugmachasini bosing va  chizilgan to'rtburchak kichik kvadratchalar bilan 

to'ldiriladi  (2.3-rasm). 

 

1.2.3-rasm.Strelka tugmasi orqali bir xil elementlarni chizish 

Vazifani vertikal to'rtburchak uchun takrorlang, bunda  tugmasini bosing. 

Ellipse Tool (Ellips) (<L>) ellipslarni chizadi. Modifikator-tugmalar 

oldindagiday <Shift> doira hosil qiladi, <Alt> markazdan chizadi. Klaviaturadagi  

 tugmalar ellipslar uchun, xuddi to'rtburchaklar uchun ishlaydi. 

Poligon Tool (Ko‘pburchak) ko‘pburchaklarni chizadi, sukut bo'yicha – 

oltiburchaklarni chizadi.  Tomonlarning sonini asbob sozlamalarida tahrir qilish 

mumkin. Modifikator-tugmalar  boshqa asboblar bilan bir xil. 

Line Tool (Chiziq)a (<\>) to'g'ri chiziqlarni hosil qiladi. <Shift> tugmachasi 

bosib turilsa, kesiklar qat'iy gorizontal, qat‘iy vertikal yoki 45 ° nishabda 

bo‘ladi.[4] 

Berilgan parametrlar bilan geometrik shakllarni chizish  

Ko'pgina hollarda aniq berilgan o‘lchamlar bilan geometrik shakllarni 

chizish talab etiladi. Bu yerda ko'plab yo‘llanmalarni tuzish mumkin, (<Ctrl> + 

<U>) bog‘lamni sozlash va shunday qilib kerakli natijani olish. Lekin asboblarning 

dialog oynalari orqali natijani olish tezroq bo'ladi. 

 Chizma asbobining dialog oynasi tanlangan asbob bilan ishchi maydonni 

bosish orqali chaqiriladi (1.2.4-rasm).  

 Har bir asbobning oynasi o'ziga xos sozlamalarni o'z ichiga oladi: 

to'g'rito‘rtburchak ellips uchun – uzunlik va kenglik, ko‘pburchak uchun - 

qo'shimcha tom1onlarning soni va "yulduz" shakli (1.2.5-rasm). 
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1.2.4-rasm. Ellipse uskunasining oynasi.  1.2.5-rasm. Ko`pburchak uskunasining 

oynasi 

 

1. Polygon Tool (ko‘pburchak) vositasi tanlang,  betning ustiga sichqoncha 

bilan  bosing va dialog oynasida uzunligi va kengligi 50 mm belgilang, 

tomonlar sonini —16, "yulduz" darajasini – 10 deb belgilang. OK bosing. 

2. Turli xil sozlamalar bilan bir necha marta takrorlang.  

3. To'rtburchak va ellips (Прямоугольник, Эллипс) asboblar oynalari bilan 

tajriba qiling.  

Endi, asosiy shakllar qanday yaratilganligini bilib, ularning o‘zgartirilishini 

va ular asosida murakkab va qiziq yangi shakllarni  yaratishini  ko'rib chiqish 

mumkin. 

Geometrik ob'ektlarning shaklini tuzatish  

Ob'ektlarning shaklini o'zgartirish uchun asosiy vosita — Pathfinder 

palitrasi (konturlarga ishlov berish) (1.2.6-rasm).  

 

1.2.6-rasm. Pathfinder palitrasi 

Palitraning yuqori qismi alohida kontur bilan ishlash uchun mo'ljallangan.  

Yuqori qismdagi buyruqlar:  
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 Join Path (ulanish) birta yoki bir nechta konturning ikkita so'nggi nuqtasini 

birlashtiradi;  

 Open Path (ochish) yopiq konturni ochadi (1.2.7 - rasm);  

 Close Path (yopish) ochiq konturni yopadi; 

 

1.2.7 – rasm. Open Path komandasi orqali bajarish. 

Reverse Path – (Yo‘nalishni o‘zgartirish) kontur yo‘nalishini qarama-

qarshisiga o‘zgartirish. Bu buyuruqning bajarilishining natijasi: agarda chiziq 

oxirida strelka yoki boshqa tugallangan elementlar bulsa, ular joylarda o‘zgaradi.  

 

1.2.8-rasm. Reverse Path komandasi orqali bajarish. 

Pathfinder(konturga ishlov berish) palitrasi tarkibiy obyektlarni tuzishga 

imkon beradi. Bir nechta shakllarni birlashtrib yoki bir biridan ayirib yangi 

formani shakllashtirish mumkin. Pathfinder palitrasi quyidagi obyektlarni qayta 

o‘zgartirish mumkin: chizilgan obyektlar; matnli freymlar; qiya qilingan matn. 

Pathfinder palitrasi ishlash rejimi: 

 Add (Qo‘shish) Oyektlar massivi umumiy konturiga qarab, yangi shakl 

yasaydi (1.2.9-rasm). 
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1.2.9-rasm Add komandasi 

 Subtract (Yuqoridagi obyektni pastdagisidan chiqarish) eng pastdagi obyektdan 

yuqorida turganlarini chiqarish (1.2.10-rasm). 

 

1.2.10-rasm Subtract komandasi 

 Intersect (kesishuv) obyektlar kesishgan joydan tashqari boshqa barcha 

obyektlarni o‘chiradi (1.2.11-rasm). 

 

1.2.11-rasm Intersect komandasi 

 Exlude Overlap (kesishgan nuqtani chiqarish) 2ta obyekt kesishgan barcha  

nuqtada ta‘sir qiladi. 
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1.2.12-rasm. Exlude Overlap komandasi 

 Minus Back (pastdagi obyektni yuqoridagisidan chiqarish) Barcha pastda 

joylashgan obyektlarni yuqorisidagidan chiqaradi. (2.13-rasm) 

Uchta kesishgan nuqta chizing. Barcha buyruqlar bajarilishini klaviatura 

yordamida  

<Ctlr> +<Z>larni yozib boshlang‘ich shaklga qayting. 

Pathfinder palitrasi yordamida qo‘shimcha ―Convert Shape” (shakllarni qayta 

shakllantirish) seksiyasi ham mavjud. 

  

1.2.13-rasm. Minus Back komandasi 

Uni shartli ravishda 3ga ajratish mumkin: 

 Burchaklarga ishlov berish 

 Shakllarni qayta shakllashtirish 

 Nuqtalarni qayta shakllantirish. 

Birinchisi shakllarning burchaklariga nestandart forma berish imkoniyatini 

beradi: odatiy doira shakliga keltirish emas, balki kesmalar va o‘yiqlar ham 

kiradi (1.2.14-rasm) 
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1.2.14-rasm. Burchakllarni shakllantirish 

Ikkinchisi istalgan formani istalganiga almashtiradi. Ya‘ni ellipsni 

uchburchak, erkin shaklni turtburchakka aylantiradi va ho kazo. 

Uchinchisi konturdagi nuqtalarni o‘zgartiradi: masalan, o‘tkir burchakni 

doiraga o‘zgartiradi yoki aksincha. (1.2.15-rasm) 

 

1.2.15-rasm. Nuqtalarni o`zgartirish. 

Shu o‘rinda aytish kerakki, Pathfiner palitrasi guruhlashtirilgan obyektlar 

bilan ishlamaydi, ya‘ni Object>Group menyusi yordamida bir butunga 

aylantirilgan obyektlar. Bu Pathfinder palitrasida ishlash uchun avval obyektlarni 

guruhlardan chiqarish kerak: Object>Ungroup. Ayniqsa bu konturga aylantirilgan 

matnga tegishli. Matnni qatorlardan konturga aylantirganda, o‘zaro 

guruhlashtirilgan bloklar vujudga keladi. Bu palitrani ishlatishdan oldin 

guruhlardan chiqarish kerakigini sababi. [7] 

Obyektlarning atributlari: 

Har bir  InDisighn obyektida 2 ta majburiy atribut mavjud: Stroke (tashqi 

chegara ―obvodka‖) va Fill(zalivka) . 

Stroke (Obvodka) – obyektning tashqi chegarasi, zalivka esa uning 

―tana‖sini to‘ldirish. Bu atributlarsiz obyektlar bo‘lmaydi: hattoki ular ‗‘bo‘sh‘‘ 

bo‘lsa ham. (1.2.16-rasm) 
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Zalivkaning ranglari va obvodkasi asboblar panelining rangni boshqarish 

blokida ko‘rsatiladi. Oldinda turgan atribut aktiv deyiladi, shunga nisbatan barcha 

rang va boshqa narsalarni o‘zgartirib bo‘ladi. 

Sukutlikda (<D> tugmachasi orqali o‘rnatiladi) obyektning Obvodkasi qora, 

zalivkasi esa ―Bo‘sh‖ (mavjud emas) (1.2.17-rasm) 

 

                         1.2.16-rasm. Obyektni tashaqi chegarasi va uni ranglash 

 

1.2.17-rasm. Rangni boshqaruv bloku va standart parametrlar Obyektni tashaqi 

chegarasi va uni ranglash 

Atributning rangini o‘zgartirish uchun, kerakli piktogrammani (obvodka 

yoki zalivka) bosing va rang tanlang (masalan, Swatches(namunalar) palitrasidan). 

Atributni ikki marta bossangiz, ranglarni saralash oynasi paydo bo‘ladi.  

Alohida o‘rinda matn freymlari turadi (matnning joylashgan hududi). Bir 

tarafdan freym ichida joylashgan matn alohida zalivka va obvodkaga ega bo‘ladi. 

Boshqa tarafdan, ichida matn joylashgan freym ham o‘z zalivkasi va obvodkasiga 

ega bo‘ladi. Shuning uchun ish jarayonida freym obvodkasidan zalivkasiga o‘tish 

mumkin, freym ichida joylashgan matnning  obvodkasidan ham zalivkasiga o‘tish 

mumkin. Buning uchun piktogramma ostida tugmachalar mavjud bo‘lib, ular Fill 

va  Strokedir. Kvadrat shaklidagi tugmachani bosib freym atributlarini ko‘rasiz, T 

harfiga o‘xshagan tugmachani bosib, siz matnning atributlari bilan ishlaysiz 

(1.2.18-rasm). 
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1.2.18-rasm. Freym va uning ichidagi matnga o`tish 

Obvodkani sozlash uchun maxsus Stroke palitrasi mavjud. Bu yerda uning  

qalinligini va rangini, chiziq turini, nuqtali chiziq, burchaklarni yasash usulini va 

oxirgi elementlarini sozlash  mumkin. 

1. Istalgan geometrik shaklni chizing. Sukutlikda atributlarni belqilang 

(‗bo‘sh‘‘ zalivka hamda 1pt qalinlikdagi qora obvodka) 

2. Pathfinder palitrasining Open Path buyrug‘i yordamida yopiq konturni 

ochiq konturga aylantiring. 

3. Obvodka parametrlarni turli xil qilib sinab ko‘ring.  

4. Kontur uchlarining elementlarni belgilang (masalan, aylana Start nuqtasida 

va strelka End nuqtasida). 

5. Pathfinder palitrasining Reverse Path buyrug‘i orqali konturning 

boshlang‘ich va so‘nggi nuqtalar joylarini o‘zgartiring va natijaga baho 

bering. 

Stroke menyusidan Stroke Style buyrug‘i orqali, xohishga ko‘ra 

shaxsiy obvodka stilini yaratish mumkin. Ochilgan oynada New tugmasini 

bosing (1.2.19-rasm). 

  

1.2.19-rasm. Obvodka stilini yaratish 
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Yangi oynada siz punktir obvodkani - nuqtalardan hamda parallel 

chiqlardan tashkil topgan obvodkani ikir-chikirigacha sozlashingiz mumkin,  

Zalivkaning tuzilishi ancha oddiy: u bir hil randa yoki gradientli 

bo‘ladi.  

Obyektning atributlariga boshqaruv panelidan ham kirsa bo‘ladi. Bu  

istalgan vaqtda har bir atribut bilan, ularning qaysi biri aktivligidan qat‘iy 

nazar, alohida ishlash imkonini beradi (1.2.20-rasm). 

 

1.2.20-rasm. Boshqaruv paneli orqali atributlar bilan ishlash 

Obyektlarni guruhlashtirish. 

Odatda bir necha obyektlarning ish jarayonida bir butundek bo‘lishi talab etiladi. 

Masalan, bir necha obyektlar illyustratsiyani hosil qiladi, va ularning o‘zaro 

joylashuvi o‘zgarmas bo‘lishi talab qilinadi. Bu holatda, birlashtirilishi kerak 

bo‘lgan barcha obyektlarni belgilab olish kerak, va menudan Object > Group 

buyrug‘ini tanlash kerak yoki <Ctrl>+<G> tugmachalarini bosish kerak. Shu 

paytdan boshlab, guruhlardan ob‘ektalardan birini tanlashda umumiy konteyner 

ko‘rsatiladi, qaysisida guruhning barcha ob'ektlari joylashgan bo‘ladi. Guruhni 

bekor qilish uchun, bosh menuyning teskari buyrug‘i xizmat qiladi Objekt > 

Ungroup (Ob'ekt > guruhdan chiqarish) - <Ctrl>+ < Shift> + < G>. 

Ob'ektlarni joylashish tartibi  

InDesign ish maydonida ob'ektlar ularni yasash vaqti tartibida "to‘plam" 

bo‘lib joylashgan. Ilgari yaratilgan ob'ektlar to‘plamning pastki qismida, oxirgilari 

esa yuqorida joylashgan.  Tartibni o'zgartirish uchun ob'ektni tanlang va Ob'ekt > 

Arrange (Ob'ekt > Tartib) menyu buyrug'ini qo'llang yoki sichqonchaning o'ng 

tugmasini bosing va ob'ektni kontekst menyusida Arrange (Tartib) buyrug'ini 

tanlang. To‘plamda ob‘ektlarning joylashishiga qarab sizga quyidagisi taklif 

qilinishi mumkin:  
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 Bring to Front (Oldinga ko‘chirish): saytda harakatlanish, qidiruv – 

  

 Bring Forward (Bir qadamga oldinga ko‘chirish) –  

 Send Backward (1qadam orqaga o‘tkazish)- <Ctrl>+<[>;  

 Send to Back (orqaga yuborish)- <Ctrl>+<Shift>+<[  

Agar bir nechta obyektlar bir-birini to‘sib qo‘ysa, sizga esa ulardan 

ostidagisi kerak bo‘lsa, bunda <Ctrl>ni bosib turib, obyektlarning to‘plamiga 

bosing. Asta-sekin harakatlanib, o‘zingizga kerakli obyektni tanlab olishingiz 

mumkin. Agar siz shu paytda boshqa obyektlarni ham tanlamoqchi bo‘lsangiz, 

<Shift>ni ham bosib turing. 

1. 4 ta bir-birini to‘sib turgan obyektlarni chizng. 

2. Atributlarni boshqarish bloki yordamida, ularni har xil rangga bo‘yang. 

3. To‘plamda qayta joylashtirish buyruqlari yordamida ob‘ektlarning 

o‘rnashgan tartibini o‘zgartiring. 

4. Bu to‘plamni <Alt> tugmachasini bosib turib ko‘chirish bilan nusxalab 

oling. 

5. Tugmachalar orqali buyruqlarni bajarib,  to‘plamning tartibini o‘zgartiring.   

Ob'ektlarni tekislash va taqsimlash. 

InDesignda obyektlarni mostlashtirish uchun alohida palitra mavjud. Align 

(Mostlashtirish)- <Shift>+<F7>. Ush bu palitrada 3 ta ish rejimi mavjud: 

ob‘ektlarni moslashtirish, ob‘ektlarni taqsimlash va ob‘ektlar o‘rtadasidagi oraliqni 

taqsimlash (2.28-rasm). 

 

1.2.21-rasm. Align palitrasi 
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Palitradan foydalanish uchun, qaysi ob‘ekt bilan ishlamoqchi bo‘lsangiz 

ushani tanlab olishingiz (eng kamida 2 ta yoki  ba‘zi paytda – 3 ta  obyektlar) 

kerak bo‘ladi. Moslashtirish (Align Objects) qanday bo‘lishini piktogrammalar 

yordamida bilib olishingiz mumkin, ya‘ni obyektning qaysi chekkasi bir chiziqda 

joylashganini. Obyektlarning taqsimlanishi (Distribute Objects) obyekt 

chekkalarining bir chiziqda joylashinuvi orqali emas, balki bir xil oraliq masofa 

orqali bajariladi. Bu holatda bir obyekt chekkasidan boshqa bir obyektning 

chekkasigacha bo‘lgan masofa boshqariladi. Va nihoyat, intervallarni 

taqsimlanilishida (Distribute Spacing) obyektlar orasidagi intervallar 

tenglashtiriladi. 

Odatda moslashtirilish va taqsimlash belgilangan obyektlarning massivlari 

chegarasida bo‘ladi, va barcha ichki masofalar umumiy band bo‘lgan maydonga 

qarab tanlanadi. 

Taqsimlash buyrig‘i uchun Use Spaсing (Masofani belgilash) bayroqchasini 

yoqish mumkin, va bunda obyektlar orasi belgilangandek masofada taqsimlanadi.  

1. Bir nechta geometrik shakl yasang va ajratib oling (4-5).  

2. Moslashtirish usullari ro‘yxatida Align to Selection (Ajratish bo‘yicha 

moslashtirish) turganiga e‘tibor qarating. 

3. Use Spaсing bayroqchasini masofalarni taqsimlash uchun  yoqing. 

4. Use Spasing maydonida obyektlarning joylashish oraliq masofasini ko‘rsating. 

5. Intervallar masofasi uchun javob beradigan piktogrammalardan birining ustiga 

bosing (1.2.22-rasm). 
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1.2.22-rasm. Distribute Spacing buyrug‘i amallanilishining natijasi. 

Qatlamlar bilan ishlash. 

InDesign programmasida qatlamlar bu – materialni maketda tashkillashtirish 

vositasi. U obyektni tez topish, tanlash va ishlov berish, mavzuviy bog‘liq 

elementlarni bir joyga jamlash, ularni ko‘rsatish yoki yashirish, bloklash yoki 

kerakli blokdan chiqarish vazifalarini bajara oladi. Qatlamlarni xuddi shaffof 

ustma-ust turgan varaqdek tasavvur qilish mumkin (1.2.23-rasm). Istalgan ob‘ekt 

yaratilgan paytida aktiv bo‘lgan  qatlamda joylashadi. Turli qatlamlarda joylashgan 

obyektlar bir-birini qisman yopib qo‘yishi mumkin. Zarurat tug‘ilganda, 

obyektlarni bir qatlamdan ikkinchi qatlamga o‘tkazish mumkin.  

 

1.2.23-rasm. Hujjatning qatlamli tizim sxemasi. 

Sukutlikda InDesigndagi har bir yangi hujjat o‘zida birta qatlamni 

saqlaydi. Qatlamning standart nomi – Layer1, Layer2 va boshq. Ishni qulay 

bajarilishi uchun, qatlamlarni qayta nomlagani ma‘qul. Masalan, "Dizayn", 

"Laklash", "Narxlar" va boshq. 
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Qatlamlarni boshqarish Layers (Qatlamlar) palitrasi orqali bo‘ladi. 

(1.2.24-rasm) 

 

1.2.24-rasm. Layers palitrasi 

Layers (Qatlamlar) palitrasi – Window>Layers (Oyna> Qatlamlar) 

hujjatning qatlamlar ro‘yhatini ko‘rsatadi va qatlamlarni  yaratish, qayta 

joylashtirish va yo‘qotish, ularni ko‘rsatish, bosmadan chiqarish imkonini beradi. 

CS5 versiyasida ush bu palitra Adobe Illustratorning xuddi shunday palitrasiga 

yaqin bo‘lib, obyektning barcha qatlamlarining nomlarini ko‘rsatadi, har bir 

obyektning tasvirlarini sozlash – ajratish, bloklash yoki blokdan chiqarish imkonini 

beradi. Ro‘yhatni ochish uchun qatlam nomidan chap tomonda joylashgan qora 

uchburchakni bosish kerak. 

Qatlamning ko‘rinishi ―ko‘z‖ piktogrammasi orqali yoqiladi, qaysisi qatlam 

nomining chetita joylashgan bo‘ladi. <Alt> tugmachasini bosganda faqat tanlangan 

qatlam ko‘rinadi boshqalari ko‘rinmaydi.   

Har bir qatlamda  o‘ziga hos rangli podsvetkasi mavjud bo‘lib, ob‘ektni 

tanlaganda, obyektning u yoki bu qatlamga tegishliligini belgilaydi.  

Kerakli qatlamni to‘g‘ridan-to‘g‘ri maketda ajratish qiyin bo‘lsa, bunda  

Layers palitrasi orqali obyektni ajratish mumkin, buni bajarisgahga obyekt 

nomidan o‘ng tomonda joylashgan qora kvadrat yordam beradi. Endi obyektni 

butunlay boshqa qatlam to‘sib tursa  ham uni ajratib olish mumkin.  

Qatlam satrida ―Ko‘z‖ oldida joylashgan maydon, bloklash belgisi uchun 

mo‘ljallangan (‗qulf‖). Butun bir qatlamni yoki alohida ob‘ektni ham bloklash 

mumkin. 
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 Qatlamning barcha sozlamalari(nom, ko‘rinish, bloklash, podsvetka va ho 

kazo) bir vaqtning o‘zida qatlamning optsiyalar oynasida bajarish mumkin, qaysisi 

ikkitalik bosish bilan chaqiriladi (1.2.25-rasm). 

 

1.2.25-rasm. Qatmla oynasining barcha konfiguratsiyasi. 

Qatlamlardan foydalanish maketning ko‘rinishi va nashr etishini  boshqarish 

imkonini beradi. Masalan, bir hujjatning o‘zida turli manzillar uchun matnning bir 

necha turi bo‘lishi mumkin, yoki rang tomonidan bir nechta variantlari bo‘lishi 

mumkin, yoki bosib chiqarish uchun bir nechta variantlar bo‘lishi mumkin – 

―Yengil‖ (asosiy bezash elementlari bilan tahrirlash va tekshirish uchun) va 

―Og‘ir‖( barcha import qilingan rasmlar va effektlar bilan so‘nggi tasdiqlash 

uchun). [6] 

1.3. Matnlar bilan ishlash 

Matn freymi nima va u nima uchun kerak?   

InDesign freym – bu hujjatdagi  har qanday (matn va import qilingan 

grafikalar) ma‘lumotni saqlaydigan konteyner. Ushbu turdagi materiallar hujjatda 

freymsiz mavjud bo‘lmaydi. Oddiy freym – bu shunchaki katta o‘lcham markerlari  

va burchak yaxlitlash belgilariga ega bo‘lgan ramka, qaysisi obyektni kerakli joyga 

ko‘chirish va o‘zgartirishga imkon  beradi (1.3.1-rasm). 

 

1.3.1-rasm. Oddiy freym. 

Matn freymi gabaritli konteynerda o‘z  xususiyatlariga va qo‘shimcha 

belgilarga ega –  kirish (chap tomondagi yuqori burchakda) va chiqish belgisi 
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(o‘ng tomondagi pastki qismda). Bu belgilar juda muhim rol o‘ynaydi va biz buni 

keyinroq ko‘rib chiqamiz (1.3.2-rasm).  

 

                         1.3.2-rasm. Matnli freym. 

Matn freymini yaratish uchun: 

1. Asboblar panelidagi Type Tool (Matn)  tanlang. 

2. Kursorni sahifaga joylashtiring. Kursor Type vositasi shaklini oladi. 

3. Sichqoncha ugmasini bosib turib, diagonal sifatida cho‘zing va to‘rtburchak 

chizing. 

4. Sichqoncha tugmasini qoyib yuboring. Ekranda freym paydo bo‘ladi, ichida 

matn kiritishingiz mumkinligini ko‘rsatuvchi matn kursori ko‘rsatiladi.[5] 

Izoh: Type vositasi har doim to‘tburchakli  freymlarni hosil qiladi. Boshqa shaklli 

freym yaatmoqch bo‘lsangiz, boshqa  geometrik shakl  vositalaridan foydalaning.  

Matni kiritish. Matnni import qilish. 

Matn matnli rejimda bo‘lgani kabi, klaviaturadan kiritiladi. Qator uzunligi 

freym ramkasi bilan cheklangan, shuning uchun qatordan qatorga o‘tish avtomatik 

ravishda amalga oshiriladi. 

Faylda tashqi manbadan matnni joylashtirish uchun; 

1. File > Place (Fayl> Joylashtirish) - (<Ctrl>+<D>) buyrug‘ini chaqirishingiz 

kerak. 

2. Import qilinadigan faylni toping. 

3. Tanlangan format uchun maxsus import sozlamalarini ko‘rish uchun Show 

Import Options (Import sozlamarini ko‘rsatish) maydonida bayroqchani  

qo‘ying.  

Tanlangan matn freymning mazmunini yangi matn bilan almashtirish uchun, 

Replace Selected Item  (Tanlangan matn o‘rniga) maydonida bayroqcha qo‘iladi.  
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Ochish tugmachasini bosgandan so‘ng, Import Options (Import sozlamari) oynasi 

ochiladi.  

InDesign dasturi turli matn muharrirlarida yaratilgan fayllarni import qilish 

imkonini beradi. Odatda bular Microsoft Word yoki past darajadagi muharrirlar – 

WordPad  yoki Notepad.  Import qilingan  fayl formati matn muharririga bog‘liq. 

Keyinchalik InDesignga  fayllarni import qilish uchun, matnli hujjatni RTF 

(Rich Text Format- kattalashtirilgan matnli format) formatida saqlashingiz kerak. 

Asl formatlashni saqlab qo‘yishga imkon beradi  va InDesignga o‘zgarishsiz  

import qilinadi. XLS/XLSC (Microsoft Excel) va DOC/DOCX (Microsoft Word)  

formatlari ham amal qiladi, ammo ―yozuvlar‖ bilan va biriktirilgan illyustratsyalar 

bilan murakkab formatlash yo‘qoladi.  

Matnni TXT formatida (eng oddiy) elektron matn formatida ham import 

qilishingiz mumkin. Formatlashsiz matnni saqlash uchun juda yaxshi bo‘ladi, 

keyin barcha sozlamalarni to‘g‘ridan  to‘g‘ri InDesignda amalga oshirilishi va 

Internetdan materiallarni saqlab qolishi mumkin, ammo import paytida kodlash 

bilan bog‘liq qiyinchiliklar bo‘lishi mumkin.  

  Har bir fayl turi o‘z optsiyalari to‘plamiga ega: 

Microsoft Word fayllari uchun optsiyalar (1.3.3-rasm):  

 Include (Yoqish) - hujjatga kiritilishi uchun lozim bo‘lgan hujjat qismini 

tanlash. 

 Table of Contents (Mundarija); 

 Index (Voqea (Mavzu) ko‘rsatgichi); 

 Footnotes va Endnotes (Havola va izohlar)  

 Use Typographer’s quotes (Chop etishda qo‘shtirniqlaridan foydalanish) - 

oddiy matn muharrirlarining qo‘shtirnoqlarini  bosmaxona ko‘rinishidagi 

qo‘shtirnoqlariga almashtirish;  

 Formatting - asl hujjatda matn formatlashiga munosabatni ifodalaydi; 

 Remove Styles and Formatting from Texts and Tables (Jadval va matn 

formatlashini va stilini yo‘qotish.) 
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 Preserve Styles and Formatting from Texts and Tables (Jadval va matn 

formatlashini va stilini saqlab qolish). 

 

1.3.3-rasm. Microsoft Word formatidagi import opsiyalari oynasi. 

Qolgan sozlamalar sahifalarni ko‘rsatilishi, stillar to‘qnashuvlarning 

yechilishi va ichki matnli grafikalar bilan ishlashi bilan bog‘liq. Yuqorida 

yozilganlardan ko‘ra bular kamdan-kam kerak  bo‘ladi.  

RTF fayllari uchun Import Options (Import parametrlari) muloqot oynasi 

o‘xshash import parametrlarini o‘z ichiga oladi. 

Microsoft Exel fayllari uchun optsiyalar (1.3.4-rasm). 

 Import uchun kerak bo’lgan jadvalning kataklari va sahifalarini tanlash; 

 Import qilishda katakning formatini tanlash; 

 Verguldan keyin kiymatlarning miqdori; 

 Bizga tanish bo‘lgan qo’shtirnoq almashinuvi. 
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1.3.4-rasm. Microsft Exel formatidagi import opsiyalari oynasi. 

 

TXT fayllari uchun imkoniyatlar 1.3.5-rasm da keltirilgan. 

 

 

1.3.5-rasm. TXT formati uchun import optsiyalari oynasi. 

 Kodlashni tanlash - ko‘pincha bizlar Windows Cyrillic  kodlashga muhtoj. 

 Platformani  tanlash (Windows/ Macintosh) 

 Til tanlovi maxsus belgilarni to‘g‘ri ko‘rsatishini taminlaydi. 

 Yangi satrga o’tishga ishlov berish. Aslida, oddiy muharrirda matnni terganda 

har bir satr, odatda, alohida xat boshi sifatida qabul qilinadi (<Enter>ni bosish 

bilanoq); internetdan import qilinuvchi ko‘plab materiallar bilan ham sodir 

bo‘ladi. Bunday holda oddiy matnni formatlash juda qiyin. Ushbu muammoni 

bartaraf qilish uchun matnni import qilish vaqtida keraksiz satrni 

ko‘chirishlardan tozalash kerakligini belgilash mumkin.  



37 
 

 Bo’shliqlar  guruhini  tabulyatsiya belgisiga qayta shakllantirish: ko‘pincha 

harf teruvchilar bir nechta bo‘shliqlar ketma-ketligi bilan tabulyatsiyani yasash 

uchun amallaydi.  

 Qo‘shtirnoqlar almashinuvi. 

Nisbatan kichik matnli qismlarni  matn muharriridan to‘g‘ridan-to‘g‘ri 

matnli freymga <Ctrl>+<C>/<Ctrl>+<V> buyrug‘i bilan  nusxalash mumkin.   

Tugmachalar kombinatsiyalari yordamida matnni belgilash 

Matn bilan ishlashda ko‘proq belgilarning aniq sonini, qatorlar yoki 

abzatslarni tanlashingiz kerak bo‘ladi. Bunday holda, bizga tugma-modifikatorlar 

yordam beradi:  

 - alohida belgini tanlash;  

 - alohida satrni tanlash;  

 — alohida so'zni va keyingi bo‘shliqni tanlash ; 

  - abzatsni tanlash;  

 <Shift> + <Nome> / < End > — satrning boshi yoki oxirigacha butun matnni 

tanlash;  

 <Ctrl>+<Shift>+ <Home>/<End> - butun matnni freym boshigacha yoki 

oxirigacha tanlash; 

 < Ctrl> + <A> - matn freymi yoki matn bloki doirasida yoki tek butun matnni 

tanlash. 

Character(Belgi) va Paragraph (Abzats) palitrasi bilan ishlash   

1.  Matn freymini yarating.  

2.  Freymning kontekst menyusini sichqonchaning o'ng tugmasi orqali chaqiring va  

Fill with Placeholder Text (Almashtirish matni bilan to'ldirish) buyruqni tanlang.   

3.  Matnning alohida so'zlarini, satrlarini va abzatslarni freym ichida ajratib, ushbu 

palitralarda maydon qiymatlari bilan tajriba qiling.  

Character (Belgi) palitrasini ko'rib chiqamiz — <Ctrl>+<T> (1.3.6-rasm).  
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1.3.6-rasm. Character palitrasi 

Garnitura (shrift naqshi): bu erda tizimda o‘rnatilgan va dastur tomonidan 

tan olingan barcha shriftlar nomlari to'plangan.  Ro'yxatning ichida harakatlanish 

palitrada o‘rnatilgan strelkachalar  orqali yoki klaviaturaning strelkachalari 

orqali bajariladi, bundan avval kursorni qaysi-bir shrit nomiga qo‘yish 

lozim. Agar siz shrift nomini bilsangiz, bunda kerakli shriftning nomini 

klaviaturadan kiritsangiz ham bo‘ladi – kiritish paytida kerakli shrift paydo 

bo'lgunga qadar ro‘yhat bo‘yicha harakatlanish bajariladi.   

 Garnitura degani nima? Ushbu parametr shriftning umumiy ko‘rinishi uchun 

javob beradi. Ko‘pincha oddiy so‘zlashuvda garnitura shrift deb bilinadi. 

 Asosiy chiziqlar to’riga bog’lash. Ushbu ikkita tugma sizga matnning qattiq 

vertikal tog‘irlashni o'rnatishga yoki bekor qilishga imkon beradi (1.3.7-rasm).  

Ularning ishlash mexanizmlarini yaxshiroq tushunish uchun, Asosiy chiziqlar 

to’rini chaqiramiz –  matn bilan ishlash uchun mo'ljallangan maxsus 

ko‘rsatgichlarga murojaat qilaylik: View > Show Baseline Grid (Ko‘rinishi> 

Asosiy chiziqlar to‘rini ko‘rsatish).   

Qo'shni ustunlardagi matn satrlari turli darajalarda ekanligi aniq ko'rsatilgan.  

Bunisi birinchi va oxirgi abzatslardagi sartrlari orasidagi masofasi turli bo'lgani 

bilan bog'liq.  Matnni to‘r bo'yicha to'g'ri moslashtirish uchun (1.3.8-rasm) uni 

sozlash kerak.   

Asosiy chiziqlar to’ri qadami. Ushbu qadam, matnni formatlaganda, 

sozlangan satrlar orasidagi masofaga teng boladi Shuning uchun buni foizlarda 

emas, balki o'zingiz punktlarda qiymatni belgilashingiz juda muhim edi.  
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Sukutlikda asosiy chiziqlar to‘ri  10 pt shrift kattaligi va satrlar orasidagi masofasi 

12 pt uchun mo‘ljallangan, agar siz bular uchun boshqa qiymatlarni kiritmoqchi 

bolsangiz, bunda   siz Edit > Preferences > Grids (Tahrirlash > Afzallik > 

To‘rlar) menyusida sozlamalarni o'zgartirishingiz kerak.  Intrement Every 

maydonida kerakli qiymatni kiriting.  

 

1.3.7-rasm.  Shriftning asosiy chizig'i yoniq bo'lganda matn. 

 

1.3.8-rasm. Asosiy chiziqlar to‘riga bog‘langan matn. 

Asosiy chiziqlar to‘rini sozlaganda, eng muhimi – satrlar oralig‘I qiymatini 

o‘zingiz kiritishingiz kerak bo‘ladi. Uni Increment Every maydoniga kiriting.  

Nima uchun bunday moslashtirish kerak?  Aslida, matnning bir nechta 

ustunlari bilan ishlashda ko'pincha abzatslardan oldin va keyin joy tashlashda va 

satrlar orasida masofani hiso-kitob qilganda xatolar paydo bo'ladi va keyin 

ustunlardagi satrlar, turli sathlarda joylashadi.  Muammoni hal qilishning bir usuli 

– bu to‘r bo‘yicha moslashtirish  tugmalaridan foydalanishdir.  Bunda siz asosiy 
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chiziqlar to‘riga satrlari mos kelmagan abzatsga  kursorni qo‘ying xolos va Align 

to Baseline Grid ( Asosiy chiziqlar to‘ri bo‘yicha to‘g‘irlash).  

Izoh: Qiymatni millimetrda yoki punktlarda kiritish mumkin, muhimi qiymat 

belgisini lotin harflarda yozish lozim. Misol uchun, siz satrlar oralig‘ini 14 pt 

o'rnatmoqchi bo'lsangiz, unda quyidagicha yozish kerak bo'ladi: 14 pt.   

Agar siz View asosiy menyusida ko‘rsatilgan asosiy chiziqlar to‘rini 

ko‘rmasangiz, demak ko‘rsatish masshtabi juda ham kichik. Sukutlikda to‘r 75%li 

masshtabida ko‘rsatiladi. Bu qiymatni o'zgartirish uchun Edit > Preferences > 

Grids (Tahrirlash > Afzallik > To‘rlar) sozlamalarni qo‘llang.  

 Betony (1.3.8-rasm) – abzats boshida dekorativ bezatilgan bosh harf. 

InDesign'da foydalanuvchi balandlik va kenglikni sozlashi mumkin. 

Balandligini sozlashda, siz harf nechta qatorga teng bo‘lishini ko‘rsatasiz.  

Kenglikni sozlashda –  nechta harf boshlang‘ich deb hisoblanadi. Bosh harf 

o‘zgarish natijasini ko‘rish uchun, balandlik maydonida kamida 2 qiymatini 

kiritish lozim. Agar1 raqami ko'rsatilsa, birinchi harf balandligi bir qatorga teng 

bo‘ladi, ya'ni oddiy harfga o'xshaydi. 

 

1.3.8-rasm. Betony ( Bezatilgan bosh harf ). 

 Hyphenate ( Sozni bo‘lish va keying satrga ko‘chirish). Ushbu bayroqchani 

yoqish orqali avtomatik ravishda so‘zlarni bo‘lish qabul qilasiz (1.3.9-rasm).  

Aynan bu yerda biz Character (Belgi) palitrasida sozlangan, lug'at 

sozlanishlarini ishlatamiz.  Agar Hyphenate bayroqchasini yoqgandan keyin 

ham matningizda hech qanday so‘z bo‘linishlari bo‘lmasa, bunda siz 

ishlatadigan lug'atni tekshiring.  Va aksincha, agar to'g'ri lug'at o'rnatilgan 
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bo'lsa, lekin hech qanday so‘z bo‘linishlari bo'lmasa, Hyphenate maydonini 

tekshiring vabayroqchasi yoqilmagan bo‘lsa uni yoqing.  

 

1.3.9-rasm.  So‘zlarni boshqa satrga ko‘chirish. 

Ko‘rib chiqilgan ikalla palitralarning ham barcha maydonlari Boshqarish 

panelida takrorlanadi.  Type (Matn) vositasi tanlansa, u ikki qismga bo'linadi: 

belgilar sozlanishlari va abzats sozlanishlari (1.3.10-rasm).  

 

1.3.10-rasm.  Boshqarish panelining ishlash rejimini tanlash. 

Belgilarni sozlash rejimida biz Character (Belgilar) palitrasidan tanish 

bo'lgan barcha maydonlarni ko'rib turibmiz, lekin ularga bu erda qo‘shimchalar 

kiritilgan, bular psevdostillar – muayan bo‘lgan masalalr uchun belgilarning imlo 

turlari. (1.3.11-rasm). 

 1.3.11-rasm. Psevdostillar piktogrammalari. 

Yuqoridagi satrda:  

 barcha katta harflar;   

 ustki indeksi;  

 ostidan chizilgan matn.  

 Pastki satrda:  

 kichik bosh harflar –  kichik harflar yozilishda katta harflarga o'xshagan;  

 pastki indeks;   

 ustidan chizilgan matn.   
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Matnli boshqaruv panelining qo'shimcha maydonlari – atributlarni (obvodka va 

to'ldirish) nazorat qilish va abzatsning asosiy sozlamalariga ruhsat, bular har doim 

absats sozlamali rejimiga o‘tmaslikni ta‘minlaydi.   

Abzatsni sozlash rejimida (1.3.12-rasm) biz oldindagiday, biz Paragraph 

(Abzats) palitrasidan tanish bo'lgan barcha maydonlarni ko'rib turibmiz va asosiy 

belgilar sozlamasiga ruhsat, lekin bundan tashqari bu erda –  ro'yxatni yaratish 

tugmalari va freymdagi matnni  kolonkalarga bo‘lish maydonlari mavjud. Oxirgi 

parametr kolonkalarni to'g'ridan-to'g'ri freym ichida sozlash imkonini beradi, 

bunda  har bir turdagi matnni bo‘lish  uchun alohida freymlarni yaratilmaydi.  

 

1.3.12-rasm. Boshqarish panelida qo‘shimcha abzats sozlamalari. 

Bog'langan matnli freymlarni yaratish.  

 Odatda, matn freymini yaratganimizdan so'ng, darhol uning katta 

konteynerini qo'shimcha markerlar bilan ko'ramiz.  Biroq,  freym yaratilgan bo‘lib, 

ko'rinmas bo‘ladi.  Bu degani siz ob'ektlarning yashirin chegarasi rejimida 

ishlayapsiz.  Ushbu rejim <Ctrl> + <H> tugmachalarini bosib chaqiriladi.  

<Ctrl> +<H> ni yana bosib, rejimlarni almashtirib ishlab ko'ring.  

 Matn freymingiz tabiati nima bo'lishidan qat'iy nazar, u har doim quyidagi 

tuzilishga ega bo'ladi (1.3.13-rasm).  

 

1.3.13-rasm. Matnli freym tuzilishi. 
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 Matn freymi matn uchun mos kelmasligi mumkin, bunda chiqish 

marker(belgisi) qizil plyus bilan almashtiriladi.  

Matn fremi o'lchamini o‘zgartiring – pastki chegarasini yuqoriga qarab 

Selection (Qora ko‘rsatgich) vositasi bilan tortib, freym hajmidan toshib ketish 

(―sitib chiqarish‖) belgisi paydo bo‘lishiga e‘tibor bering.   

Bunday holatda, eng to'g'ri echim – ikkinchi freymni yaratish, buning ichida 

birinchi freymga sig‘magan narsalar joylashadi.  Bunday freymlar bog'langan deb 

ataladi, uni yaratish uchun freymdan toshib ketish belgisini bosish kerak (qizil 

plyus) (kursor ko'rinishini o'zgartiradi) va so'ngra keyingi freymni yaratish uchun 

ish maydonini bosing (u avtomatik tarzda birinchi freym bilan  bir xil shakli va 

hajmiga ega bo‘ladi).   

Freymlarning orasidagi aloqani ko'rish uchun, menyu View > Extras > 

Show Text Threads (Ko‘rinish > Qo‘shimcha > Matnli freymlarning aloqalarini 

ko‘rsatish).  Endi matnli freymni tanlasangiz, matnli bloklar orasiga ko'k rangli 

ulash chizig‘i ko'rsatiladi (1.3.14-rasm).  

 

1.3.14-rasm. Bog‘langan freymlar. 

Bog'langan freym paydo bo'lgandan so'ng, kirish va chiqish belgilarining 

ko‘rinishi o‘zgarishiga e'tibor bering.  Endi birinchi freymda chiqish belgisi 

uchburchak-ko‘rsatgichga ega, bunusi freym davomi borligini bildiradi, bu yagona 

emas.  Ikkinchi freymning, aksincha, kirish belgisini o'zgaradi.  Unda ham 

uchburchak-ko‘rsatgich bor –  bu degani freymning boshlanishi boshqa matnli 

freymda joylashgan.  



44 
 

Matn freymlari orasidagi bog'liqlik nimani anglatadi?   

Birinchidan, buning yordamida siz matnlarni freymlar orasida 

taqsimlashingiz mumkin: birinchi freymni kichiraytirsangiz, ortiqhca bo‘lgan matn 

keyingi freymga o‘tishini ko‘rasiz.   

Ikkinchidan, o'zaro bog'langan freymlarda turli o'zgartirishlarni bajarish 

qulay.  Misol uchun, bir vaqtning o'zida barcha maqolada ba'zi sozlamalarni 

o'zgartirish kerak bo'lsa.  Matn turli freymlarda yoki turli sahifalarga 

joylashtirilgan bo'lsa ham, uni juda tez bajarishingiz mumkin.  Freymlarning bu 

xususiyatiga gazetalarda oldindan e'lonlarni rejalishtirilishi asoslanadi: birinchi 

sahifada maqolaning boshi bosib chiqiladi va unga izoh beriladi –  "Davomi … 

betida"  va ko‘rsatilgan betda davomi bosib chiqiladi (1.3.15-rasm).  Tasavvur 

qilingki, siz huddi shunday material ustida ishlayapsiz va oxirgi daqiqada siz 

bilasizki, u boshqa o'lchamdagi yoki boshqa shriftda yozilishi kerak ekan!  

Bog'langan matnli freymlar, matnning joylashuvi qat'iy nazar, barcha matnga bir 

vaqtning o'zida o'zgarishlar kiritishga imkon beradi.  

 

1.3.15-rasm. Maqolaning boshlanishi gazetada ichki mamlakatlarga qarab. 

  O'zaro bog'langan freymlar zanjiridagi matn material deb nomlanadi.  

Yuqorida bayon etilgan afzalliklarga qo'shimcha ravishda, matn freymlarning 

bog‘likligi yana birta afzalligi mavjud, uni siz ishlatgandan keyin baholab bilasiz: 

barcha materiallar matn muharriri rejimida bitta matnli blok sifatida ko'rsatilgan.  

 Bog‘lanmagan freymlarni qanday bog'lash mumkin va bog'langan 

freymlarni qanday ochish mumkin? 
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  Hujjatlaringiz bir-biriga bog‘lanmagan matnli freymlar bo'lsa, kerak 

bo'lganda siz o'zingizning ularni bog‘lashingiz mumkin.  InDesign'da ushbu vazifa 

juda oddiy: siz tanlagan freymning chiqish markerini va bog'lovchi freymning 

kirish markerini sichqoncha bilan bosishingiz kerak xolos (1.3.16-rasm.).  

 

1.3.16-rasm. Freymlarni bog‘lash. 

Nima uchun bunday ehtiyoj paydo bo'lishi mumkin?  Masalan, turli xil 

matnli fayllardan matnni kiritish paytida.  Agar u mantiqiy ravishda bog'liq bo'lgan 

bo'lsa ham, jismonan shu matnni matnga bog'lash lozim va u bilan yahlitlikka 

ishlash uchun uni umumiylashtirish kerak boladi.  

Keling, matn freymlar bog'lanishidan xalos bo'lishni istagan vaziyatni ko'rib 

chiqaylik (masalan, darslikning muallifi paragraflarning joyini almashtirishga 

qaror qildi), agar freymlarni asl shaklida bog'lashni davom ettirsangiz, matnni 

freymlar bo'ylab harakatlanishini kuzatish qiyin bo‘ladi (1.3.16-rasm).   

Freymlarning bog‘ligini ochish uchun, birinchi freymning chiqish markerini 

sichqoncha bilan ikki marta bosing.  Ammo, bu erda bir nozik joyi bor: aloqa 

uzilib qolganidan so'ng, "uzilgan" freym bo'sh qoladi va uning matni oldingi 

freymda yig'iladi (1.3.17-rasm).   
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1.3.17-rasm. Uzilgan bo‘shagan freym. 

Odatda bunday hodisalar bizni qoniqtirmaydi.  Agar mustaqil freymlarni 

olishni istasangiz, lekin uning ichidagi matnning joylashtirish tartibini 

yo'qotmaslik uchun nima qilish kerak?  Bunday holda, siz <Alt> tugmachasini 

bosib turib, tartib bilan matn bloklarini nusxalang, nusxalangan bloklar 

bog‘lovlarsiz bo‘ladi (1.3.18-rasm).  Ularni endi kerakli tartibda bog‘lashlashingiz 

mumkin bo‘ladi.  [7] 

 

1.3.18-rasm. Nusxalash yordamida uzilgan freymlar.  

Xulosa. 

Bitiruv malakaviy ishning I bobida Adobe InDesign dasturi bilan tanishish, 

obyektlar, geometrik figuralar, matnlar bilan ishlash bo’yicha ma’lumotlar 

keltirilgan. Har bir bo’limning imkoniyatlari keng va batafsil tushuntirib berilgan. 

Har bir bo’limda tushuntirilgan nazariyalar rasmlar asosida yanada tushunarli qilib 

keltirib o’tilgan. 
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II BOB.  ABOBE INDESIGN MUHITIDA ISHLASH 

2.1. Ko`p sahifali hujjat 

Ko'p sahifali hujjatni yaratganda sozlash  

Yangi hujjat yaratishni o‘rgandik. Endi bu harakatni katta (ko'p sahifali)  hujjat 

uchun o‘rganaylik (2.1.1-rasm). 

 2.1.1-rasm. Yangi hujjat yaratish oynasi. 

1.  A4 formatdagi hujjatni yarating, bitta ustunli (kolonka), har bir tomonidan 

hoshiyalari 20 mm bo‘lsin.  

2.  Sahifalar soni 10 teng bo‘lsin.  Bu bizning o'quv harakatlarimiz uchun katta 

joyni beradi.  

3.  Master Text Frame (Shablondagi matn freymlari) maydonida  bayroqchani 

qoying. Bunisi hujjatda katta matnni joylashtirish jarayonini 

soddalashtirishtiradi.  

4.  Working.indd deb nomlangan faylni qattik daskda saqlang.  

Sahifalar palitrasi (Pages) 

Oldinda bizlar  Layout > Margins and Columns (Maket > Maydonlar va 

kolonkalar) palitrasi orqali har bir sahifani sozlashi juda ko‘p vaqtni oladi va uni 

avtomatlashtirish lozim.   

Bunday vosita mavjud va InDesignda sahifalar bilan ishlash  asosiy vositasi 

yordamida amalga oshiriladi – Pages (Sahifalar) palitrasi (2.1.2-rasm). 
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2.1.2-rasm. Pages (Sahifalar) palitrasi 

Ushbu palitra hujjatning barcha sahifalarini ko'rsatadi, ularni qo'shish, 

o'chirish va ko‘chirish imkonini beradi, sahifadan sahifaga o'tishni ta'minlaydi, 

asosiysi esa – unda master-shablonlar mavjud.   

Master-shablonlar:  yaratish, sozlash, ierarxiya  

Master-shablonlar –  ko‘p sahifali hujjat bilan ishlashni optimallashtirish asosiy 

vositalaridan biri deb hisoblanadi. Ularda maketning nusxalangan elementlari 

joylashadi.   

Odatda master-shablonlarda nima joylashadi?  Masalan, kolontitullar, shifa 

nomeri, ko‘rsatgichlar yoki grafik elementlari, qaysilari kolontitulni bezaydi, 

demak nashrda  takrorlangan, maketda joylari o‘zgarmas  har qanday elementlar.   

Master-shablonlar faqatgina nashrnig elektron ko‘rinishida mavjud (ular chop 

etilmaydi, garchi oddiy sahifalarda biz ko'rgan master-ob‘ektlar, albatta chop 

etiladi). Bu hujjatning qo'shimcha sahifalari, bularga faqat master-shablonda 

joylashgan ob‘ektni ko‘rsatish uchun oddiy sahifalar murojaat qiladi.   

Birinchi qarashda, bularning barchasi juda murakkab ko'rinadi, lekin aslida 

master-shablonlar ishni engillashtirish asosiy vositasidir, chunki bir marta barcha 

belgilar, ko'rsatmalar va takrorlanuvchi ob'ektlar bilan master-shablonni 

yaratsangiz, siz endi ularni barcha oddiy sahifalarda ko‘rasiz.   
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Hujjatda bir nechta master-shablon bo'lishi mumkin. Bular o‘sha payt kerak 

bo‘ladiki, qachon hujjatda turli ko‘rinishda sahifalar mavjud bo‘lsa.  Misol uchun, 

mahsulot katalogida har bir mahsulot turi uchun o'ziga hos  dizayn elementlarini 

mavjud, ushbu turdagi mahsulotlar uchun piktogramlar, o‘zining kolontitullari 

mavjud. Shunga ko'ra, siz mahsulot turiga munosib master-shablonlarga ega 

bo'lasiz.  

Odatiy bo'lib, master-shablonlar ingliz alifbosi harflari bilan nomlanadi. 

Birinchi master shablon —  A-master, keyingi B-master va boshqalar (5.3-rasm). 

  2.1.3-rasm. Master-shablonlar Palitrasi 

Master-shablonlarni yaratish  

Master-shablonlarni va oddiy sahifalarni sozlash bo'yicha barcha ishlar 

Pages (Sahifalar) (<F12>) palitrasidan amalga oshiriladi.  Barcha palitralar singari, 

uni Window > Pages (Oyna > Sahifalar) menyusidan chaqirish mumkin. 

Pages palitrasining yuqori qismida master shablonlari haqida ma'lumot 

mavjud, pastki qismida — oddiy sahifalar haqida.  Bizning misolimizda o'n 

sahifali hujjat uchta master shablonga ega. 

Kerakli sahifaga yoki master-shablonga o'tish palitraning kerakli sahifaning 

piktogrammasiga sichqonchani ikki marta bosish bilan amalga oshiriladi  (bir 

martalik bosish piktogrammani ajratadi, ammo o‘tish bajarilmaydi). Master- 

shabloniga o'tish xuddi shunday bajariladi (ikki marta bosish) 

Faol sahifa yoki shablon (ya'ni ayni paytda ish olib boriladigan sahifa) 

Pages palitrasida teskari imzo (qora fonda oq) ajratiladi.  Master-shablonning 

ustida ishlaganda biz, mashtabga qaramay, faqat birta betni ko‘ramiz, lekin oddiy 

sahifada ishlaganda, masshtab kichirayganda nashr butunlay ko‘rinadi.  Bundan 

tashqari, pastqi chap burchakda faol betning nomeri va master-shablonning nomi 

ko‘rsatiladi. (2.1.4-rasm). 
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2.1.4-rasm. Aktiv sahifa va aktiv shablonlar 

1.  Chapter7\Diver.indd faylini oching va A-master hujjatning master- shabloniga 

o'ting.  

2.  Hujjatning chekkasida joylashgan havo pufakchalarni nusxalab oling.  

3.  Ish fayliga qayting.  

4. Pufakchalarni Paste in Place (O‘sha joyga ko‘yish) buyrug'ini qo'llab    

shablonning ichki betiga joylashtiring (<Ctrl>+ < Alt>+ < Shift>+ < V>).  

5.  Kontekst menyusini sichqonchaning o'ng tugmasini bosib chaqiring.  

6.  Apply Master to Pages (sahifalar uchun shablonni qo'llash)  buyrug'ini tanlang 

va ochilgan muloqot oynasida 2-8 oralig'ini belgilang.  

Pufakchalar barcha sahifalarda paydo bo'ladi. 

Shablonni qo'llashning yana bir usuli – uni shablon maydonidan surib 

to'g'ridan-to'g'ri sahifaning piktogrammasida joylashtiring, lekin bu usul ancha 

sekin, chunki har bir sahifa bilan alohida ishlashga to‘g‘ri keladi; bunda xatolik 

tushish ehtimolligi sezilarli darajada oshadi.[4] 

Sahifalarni raqamlash  

Ko'pincha master-shablonlar sahifalarni raqamlash uchun ishlatiladi.  

Buning uchun master-shablonda maxsus raqamlash markeri mavjud va master-

shablonga biriktirilgan barcha boshqa sahifalarda o‘sha joyda sahifa raqami paydo 

bo'ladi. 

Master-shablonidagi raqamlash belgisi master-shabloning nomida 

ishlatiladigan harf bilan belgilanadi.  

1.  B-master shabloniga o'ting.  

2.  Pages palitrasi kontekst menyusida yangi New Master-ni (Yangi shablon) 

buyrig‘ini  tanlang. 
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3.  Shablonni yaratish oynasida C-master nomini kiriting, Based on maydonida B-

master tanlang. Yangi shablon paydo bo‘ladi, u hali xuddi B-master shablonga 

o'xshaydi. 

4.  Ushbu shablonda gradiyent nuqta chizig'ining chap pastki chetida 8x8 mm 

hajmli qora kvadratni chizing (2.1.5-rasm).  

5.  Type asbobi bilan  kvadrat ustida matn freymini yarating, uning ichida kursor 

yonib-o'chib turishi kerak. Matnni oq (Paper) rang bilan to'ldiring (zalivkasini).  

6.  Sichqonchaning o'ng tugmasini bosing va ochilgan ro'yxatdan Insert special 

Character >Markers>Current Page Number (Maxsus belgini 

qo'shish>Markers>Joriy sahifa raqami) buyruqni tanlang.  Matnli freymda C harfi 

paydo bo'ladi – shablon prefiksi. Oddiy sahifada u raqam bilan almashtiriladi. 

 

2.1.5-rasm. C-master shablonini yangi elementi. 

7.  Matn freymning shaklini va hajmini to'g'rilang, belgini quyidagi tarzda 

formatlang: raqam podlojkaning o'rtasida joylashtirilsin (shrift garniturasi  

ixtiyoriy, o'lchami = 14 pt, tekislash o‘rtadan, matn freymi podlojkaga nisbatan 

simmetrik joylashgan).  

8. Matn freymini matn bilan birga o‘ng tarafdagi ichki betiga joylashtiring.    

9.  2-9 sahifalariga shablonni qo'llang (2.1.6-rasm). 
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2.1.6-rasm. Nomerlangan sahifa 

Sahifa raqami kolonraqam deb ataladi va sahifaning har qanday qismida 

joylashishi mumkin,  asosiy matn freymning tashqarida. Odatda kolonraqamni 

yuqori yoki pastki tashqi burchakda joylashtiradilar, lekin tomonning markazida 

ham joylashtirish mumkin.  Kolonraqamni joylashtirish uchun ichki maydon mos 

kelmaydi: u erda kolonraqam ko'rinmaydi. 

Ko‘pincha turli yozuvlar ( muallifning nomi, bo'limlarning nomi, jurnallar 

uchun-sarlavhalar, gazetalar uchun-sana, naqshning gafik elementlari  va hokazo) 

master-shablonga chiqariladi, ular kolontitul deb ataladi va huddi kolonraqamday 

sahifaning ustki yoki pastki hoshiyasida joylashadi.   

Muayyan sahifadan hujjatni raqamlash   

Katta nashrlar bilan ishlashlaganda, ayniqsa, kitoblar bilan, ko‘pincha 

raqamlashni boshlash birinchi betdan emas, balki ichki sahifalardan birisidan 

boshlashga to‘g‘ri keladi — misol uchun, birinchi sahifalar muqova bo'ladi. 

Buning uchun quyidagi bajariladi: 

1.  Kerakli hujjat sahifasini Pages(sahifalar)  palitrasidagi piktogrammasiga ikki 

marta bosish bilan faollashtiring. 

2.  Kontekst menyusida Numbering & Sections Options buyrug'ini tanlang va  

ochilgan muloqot oynasida Start Page Numbers at maidonini yoqing va 

raqamlashni qaysi raqamdan boshlashingiz kerak bo'lgan raqamni kiriting (2.1.7-

rasm).   

 

 

2.1.7-rasm. Bosh sahifani o`rnatish 
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Ushbu sozlash yordamida siz raqamlashni ketma-ketligini o‘zingiz 

sozlashingiz mumkin, yani har bir bo'limning raqamlanishi yangitan boshlanadi.  

Raqamlash turlari (stillari). 

Hujjatni har biri o‘z nomerlangan ro‘yhatiga ega bo‘lgan bo‘limlarga bo‘lish  

har qanday ish adabiyotlariga  tegishli bo‘ladi. Bunday nashrlarda turli hil 

raqamlashni amallash lozim yoki prefikslarni ishlatish mumkin, bundan tashqari 

ularning qo‘llanilishi, sozlanishlar to‘qnashuviga olib kelmaydi va hujjat 

ma‘lumotlarini ko‘rgazmali kilib beradi. 

Keling, bizning ish hujjatimizda birinchi uchta sahifa Rim raqamlari bilan 

raqamlangan va beshinchi sahifadan raqamlash 1 raqamidan qayta boshlanadi, 

lekin Arabcha raqamlar bilan (2.1.8-rasm). 

 

2.1.8-rasm. Turli xil stillarda sahifani raqamlash 

1.  Hujjatning birinchi sahifasini faollashtiring.  

2.  Numbering & Sections Options (raqamlash va bo’limni sozlash) buyrug'ini 

chaqiring va dialog oynasida Style ro'yxatidan raqamlashning kerakli uslubini 

tanlang (birinchi bo’lim uchun bu Rim raqamlari).  

3.  Beshinchi sahifaga o'ting. Sahifalarni yangidan raqamlash uchun, ush bu sahifa 

birinchi deb hisoblanadi.   

4.  Raqamli sozlash muloqot oynasini qayta chaqiring. Oynaning  yuqori qismida 

Page Numbering at bandini yoqing va maydonga 1 raqamni kiriting. Stale 

ochiladigan ro’yxatidan “Arab raqamlari” variantini tanlag.   

Sahifa raqamlariga prefiksni qo'shish  
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Hujjatning sahifa raqamlariga prefiksni qo'shish kerak bo'lgan vaziyatni ko'rib 

chiqamiz. Keling, yo'l harakati inspektorlari uchun ko'rsatmalar tayyorlaymiz. Bu 

erda turli toifani olish uchun imtihonlar ro‘yxati berilgan.  

Bizga A, B, C, D prefikslari kerak bo‘ladi. 

1.  Ish hujjatiga 15 sahifa qo'shing: Pages palitraning maydoni bo'sh joyida 

sichqonchaning o'ng tugmasini bosing va Insert Pages (Sahifalarni qo'shish) 

buyrug'ini chaqiring, muloqot oynasida miqdor maydonida – 15 ni tanlang, 

qo‘shish nuqtasi maydonida – At End of Document  (hujjat oxirida), shablon 

maydonida — C-master.  

2.  № 5 sahifani faollashtiring. A prefiksi bilan belgillangan bo'lim uchun u 

boshlang'ich bet bo'ladi,  bu erda A toifa imtihoni uchun topshiriqlar to'planadi.  

3.  Numbering & Section Options (Raqamlash va bo'limni sozlash) muloqot 

oynasini chaqiring.  

4.  Seletion Prefix maydonida prefiksining belgisini kiriting — A-. 

5.  Muloqot oynasining pastki qismida Include  Prefix  when Numbering Pages 

(Sahifalarni raqamlashda prefiks qo'shing) maydonida bayroqchani qo‘ying (2.1.9-

rasm).  

6.  11-sahifasida B prefiksi uchun vazifani takrorlang, 15 sahifasida esa – C uchun 

va 21 sahifasida – D uchun. 

 

2.1.9-rasm. Prefiks asosida sahifani raqamlash 
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Shunday qilib, biz grafik va raqamlash darajasida tashqi sahifa dizaynini 

yaratdik  va endi faqat matnni olish va uni joylashtirishi  qoladi.  

O'zgaruvchan kolontitullarni yaratish 

Bu erda biz" suzuvchi " kolontitullarni yaratamiz, ular ichidagi  ma'lumot 

zarur bo'lganda, o'zgaradi. Masalan, kitobning o'zgarmas nomi bilan bo'limlarning 

nomi o‘zgaradi. 

Master-shablonda o'zgaruvchan kolontitullar uchun  maxsus maydon 

belgilanadi. Odiiy sahifa uchun,  bu maydonda Numbering & Section Options 

oynasida foydalanuvchi ko'rsatgan narsalar ko‘rsatiladi, masalan, raqam yoki 

kerakli bobning nomi. 

Avvalo, master-shablonida maxsus maydon yaratamiz.  

1. Pages (Sahifalar) palitrasida piktogrammani ikki marta bosing va C-master 

master-shabloniga o‘ting. 

2. Type (Matn) vositasi bilan chap ichki sahifasida butun kengligi bo‘yicha matn 

freymini yarating va uni shuday joylashtiringki, shriftning asosiy chizig‘i 

kolontitul chzig‘idan 1 mm  baland bo‘lsin. 

3. Freymga "Haydovchilik guvohnomasini olish uchun imtihon" degan matnni  

kiriting va uni o‘z xohishingizga qarab formatlang (2.1.10-rasm). 

 

2.1.10-rasm. Doimiy kolontitul 

4.  Freymni o'ng ichki sahifasiga nusxalang, undagi barcha matnni ajrating va 

sichqonchaning o'ng tugmasini bosib, maxsus belgilarni qo'shish buyrug'ini 

chaqiring Insert Special Character > Markers > Section Marker (Maxsus 

belgini qo'shish > Markerlar > Marker qismlari).  
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5. Matn doirasida Section  so'zi paydo bo'ladi. Bu degani – siz maxsus doirani 

belgilab oldingiz, bunda odddiy sahifalarda Nuberning & Section Options 

oynasidagi sozlamalarida  belgilangan ma‘lumotlar ko‘rsatiladi (2.1.11-rasm).  

 

2.1.11-rasm. Almashinuvchi axborot uchun section maydon. 

Endi har qanday oddiy nashriyot sahifasiga o'ting bo'lsa, biz ishga tushirish 

ko'rasiz - bu maydon. Bu sohada nima va qachon kiritilishi kerakligini aniqlash 

kerak.  

6. № 5 sahifani faollashtirishtiring. 

7. Nuberning&Section Options buyrug‘ini chaqiringva ochilgan oynaning 

Section Marker maydoniga ―A kategoriyali haydovchilar uchun topshiriqlar‖ 

degan matnni kiriting (2.1.12-rasm).  

 

2.1.12-rasm. Section marker maydonida qiymat kiritish. 

8.  B kategoriyasi uchun 11 sahifasida vazifani takrorlang, 15 sahifasida – C uchun 

va 21 sahifasida – D uchun.  
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Hujjatning barcha sahifalarida, master-shablonga Section belgisi kiritilgan 

joyida Nuberning&Section Options oynasining Section Marker maidoniga 

kiritilgan ma‘lumot paydo bo‘ladi.   

Har bir bo‘limning boshlang‘ich sahifasi piktogrammasining ustgi chetida 

joylashgan qora uchburchak bilan belgilanadi (2.1.13-rasm). 

 

2.1.13-rasm. Pages palitrasida, bosh sahifa va suzuvchi kolontitullar 

Sahifaning o`lchamini o’zgartirish 

Alohida olingan sahifaning hajmini va yo‘nalishini o‘zgartirmoqchi 

bo‘lsangiz, uni maketda Page asbobi bilan ajratib oling va Nazorat panelida yangi 

hajmni belgilang  (2.1.14-rasm). [5] 

 

2.1.14-rasm. Sahifa o`lchamini o`zgartirish. 

2.2. Stillar, yaratish va ishlatish 
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Abzats va belgilar stillari –  chop etish paytida ishni osonlashtirish va 

tezlashtirish uchun kuchli vosita bo'lib, matn uchun ular huddi sahifalar uchun 

master-shablonlari bilan bir xil rol o'ynaydi: ular takroriy elementlarni bitta nazorat 

markaziga to'plashda yordam beradi, ammo bu safar ob'ektlar emas, sozlamalar 

bo‗ladi. Ularsiz murakkab tuzilishlarda ishlash juda katta miqdorda vaqt va 

mehnatni talab qiladi, shuning uchun boshidan stillar asosida matn bilan ishlashga 

o'rganish yaxshi bo'ladi. 

Stillar bizga nima beradi? 

Birinchidan, stillar matnli formatlashning umumiy majmuasini birgalikda 

qo'llashga imkon beradi: siz barcha kerakli parametrlarni o'rnatganingizdan so'ng, 

ularni birgalikda bir marta bosish bilan bir vaqtning o'zida qo'llashingiz mumkin. 

Ikkinchidan, matnda ba'zi parametrlarni tezda o'zgartirishingiz kerak bo'lsa, 

stillar juda qulay. Masalan, barcha bir xil hujjat sarlavhalarida shriftni o'zgartirish 

uchun, bu shriftda yozilgan barcha so'zlarni qidirish va ularni qo'lda tahrirlash 

o'rniga, uni stillar sozlamalarini o'zgartirish kifoya. 

Uchinchidan, stillar sizga avtomatik ravishda mundarijani yaratish imkonini 

beradi.  

Adobe InDesign'da stillar bilan ishlash uchun Paragraph Styles  (Abzats 

stillari) va Character Styles (Belgi stillari) palitralaridan foydalaniladi. Ularning 

nomlaridan ko'rinib turganidek, sahifalarning abzatslarini formatlash 

parametrlarini (Paragraph Styles) va bitta alohida olingan belgi uchun ko'rinish 

sozlamalarini (Character Styles) saqlash uchun mo'ljallangan. 

Turli xil darajadagi formatlash parametrlari o'rtasidagi ierarxik munosabatlar 

yo'l ma'lumotlarining ierarxiyasiga o'xshaydi: yo'l ishoralari asos bo‘ladi, svetofor 

va yo'l belgilaridan unga ustunlik qiladi (agar ular mavjud bo'lsa, ular amallanadi 

va agar bo'lmasa, ishoralar amallanadi), vaqt belgilari va yol harakat nazoratchilari 

barcha ustunlikka ega. Maket ustida ishlashda yo'l ishoralarning rolini abzatts stili 

o‘ynaydi, u formatlashning eng keng to'plami, belgilar va svetoforlarning roli - 

belgi stili, alohida belgilarning formatlash sozlamalari bilan chegaralangan va yo‘l 
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harakati nazoratchining o'rni - alohida belgilarni, so'zlarni yoki iboralarni qo'lda 

formatlashni o'z ichiga olgan xat stilida ijro etiladi. 

Bundan kelib chiqayapti –  ish Paragraph Styles palitrasi bilan boshlanishi 

kerak.[8] 

Abzats stilini yaratish va qo'llash 

Paragraph Styles palitrasi abzatsdagi sozlamalar (stillar) haqidagi 

ma'lumotlarni saqlaydi. 

Abzats – bu abzats so'nggi belgilar orasidagi matnning bir qismi hisoblanadi. 

Shunday qilib, har qanday sarlavha abzats deb hisoblanadi va unga ham stilni 

tayinlashi kerak. 

Har qanday hujjatda, kamida ikkita stil aniqlanishi mumkin - sarlavhalar va 

asosiy matn uchun. Aslida, odatda hujjatda ko'proq stillar mavjud, chunki har bir 

izoh, eslatma, kirish so'zlari, va takrorlangan matnlar ham o'z stili bilan tuziladi. 

1. Hujjat yarating:  

 Print;  

 Facing Pages;  

 Master Text Frame;  

 Paper Size = А4;  

 Columns Number =1;  

 Margins = 20 mm barcha tomonlar bo‘icha.  

2. Chapter8\Lord_Emsworth.doc faylini import qiling. 

Bu bizning ishchi faylimiz bo'ladi. 

Stillar palitrasi quyidagicha chaqiriladi Window > Type&Tables > 

Paragraph Styles (Oyna> Matn va jadvallar> Paragraf stillari) - <F11> (6.1-

rasm). Bu tezkor tugmalardan foydalanish ishni sezilarli darajada tezlashtirishi 

mumkin bo'lgan vaziyatlardan biridir! 
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  2.2.1-rasm. Paragraph Styles palitrasi 

Stil sozlamalarini chaqirish uchun, palitra ostidagi yangi elementni yaratish 

tugmachasini bosing yoki mavjud stil qatoriga ikki marta bosing. Paragraph Style 

Options Paragraf (Abzats stil sozlamalari) oynasi paydo bo'ladi. 

Asosiy ilovalarni va eng muhim sozlamalarni ko'rib chiqamiz. 

 General  (Umumiy Sozlamalar) (2.2.1-rasm). 

Ushbu ilova yangi stilning nomini belgilash va hujjat iyerarxiyasi stilini sozlash 

imkonini beradi (stillar iyerarxiyasi master-shablon iyerarxiyasiga o'xshaydi: 

asosiy (yuqori) stili o'zgartirilganda, uning assida yaratilgan barcha stilarda ham 

muvofiq o'zgarishlar amalga oshiriladi). 

Stil nomi Style Name maydoniga kiritiladi. Shablonlar bilan ishlashda bo'lgani 

kabi, stillarga aniq nom berilgani maqul, chunki har qanday vaziyatda siz yoki 

hamkasblaringiz bularni osonlik bilan amallshi mumkin.   

 

2.2.2-rasm. Paragraph Style Options palitrasi. General ilovasi 

Based On (Asoslangan...) ochiladigan ro'yxatda, asosiy stili tanlanadi. 

Tabiiyki, u mavjud bo'lishi kerak. Ushbu hujjatning birinchi stili uchun No 

Paragraph Styles (Stil maxjud emas) tanlanadi. Asosiy stilni ishlatishi, yangi 

stilda barcha parametrlarni sozlash imkonini bermaydi, faqat siz o'zgartirishni 

xohlaydigan sozlamalarni (qolganlari asosiy yangi stilga o'tkaziladi) sozlash 
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imkonini beradi. Qo'lda sozlangan narsalar yangi stilni oldingi versiyadan ajratib 

turadi. 

Agar siz barcha zarur stillarni va ularning o'zaro bog'liqligini aniqlash uchun 

ishni boshlashdan oldin aniqlagan bo'lsangiz, amalda siz faqat 1-2 stilni 

sozlashingiz kerak, qolganlari esa ierarxik ravishda ular bilan bog'langan bo'lib, 

faqat bir nechta parametrlarni o'zgartirishni talab qiladi. Ayniqsa, asosiy stillar 

bilan ishlash texnologiyasi, masalan, sarlavhalar bilan ishlashda qulay bo'ladi. 

Odatda, ular bir hil garnitura bilan yoziladi, harflar va kegllarda farqlanadi.  

Ro‘yhatdagi stilni tanlash Next Style (Keyingi stil) keyingi abzatsning stilni 

aniqlaydi. Misol uchun, sarlavha stilini sozlaganda, keyingi abzats (bu asosiy matn 

bo'lishi mumkin) stilini asosiy matn stili deb belgilash mumkin. Avvalgi holatda 

bo'lganidek, stil mavjud bo‘lishi kerak. 

Hujjattda asosiy matn uchun Main stilini yarating. Ushbu hujjatda hozgacha 

hech qanday stil yaratilmaganligi sababli, Based On maydonida biz No 

Paragraph Styles qoldiramiz, Next Style maydonida Same Style (Huddi o‘sha)ni 

tanlaymiz. 

 Basic Character Formats  (Asosiy belgilar formatlari). 

Ushbu ilova Character (Belgi) palitrasiga o'xshash. Haqiqatan ham, bu ilovada 

to'plangan parametrlarni siz bir necha marta sozlagansiz, bu ishni matnni 

formatlashda palitra yoki boshqarish panelining tegishli maydonlari yordamida 

bajargansiz (6.3-rasm). 

 

2.2.3-rasm. Paragraph Style Options palitrasi. Basic Character Formats ilovasi. 
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Bu yerda, birinchi navbatda quyidagilar sozlanadi:  

 garnitura va yozilishi (Font Family, Font Style );  

 kegl (Size);  

 satrlar orasi (Leading);  

 kerning va trekking qiymati (Kerning, Tracking);  

 agar xohlasangiz, bu erda siz registni, matn effektlarini va boshqalarni ham 

sozlashingiz mumkin. 

Ushbu ilovada stilingizni quyidagicha o'rnating:  

Font Family = Minion Pro;  

Font Style = Regular;  

Size = 10 pt;  

Leading = 12 pt;  

Kerning = Optical;  

Tracking = 0.  

 Advanced Character Formats (Qo‘shimcha belgilar sozlamalari) - aslida, bu 

ilovaning barcha parametrlaridan (2.2.4-rasm), faqatgina bitta, lekin juda 

muhimi haqida so‘z yuritamiz: lug'atni tanlash (Language). Unga asosan 

so‘zlarni ko‘chirish amalga oshiriladi va lug'at noto'g'ri tanlangan bo'lsa, 

sozlarni to'g'ri ko‘chirib bo'lmaydi. 

Qolgan sozlamalar (Horizontal / Vertical Scale - belgilarning masshtabi, Scew 

- ularning egilish burchagi va Bazeline Shift - asosiy chiziqni ko'chirish) esingizda 

bo'lsa, Baseline Shift dan tashqari barchlari shrift naqshini buzishga olib keladi va 

ularni juda ehtiyotkorlik bilan ishlatish kerak. 
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2.2.4-rasm. Paragraph Style Options palitrasi. Advanced Character Formats 

ilovasi. 

 Indents and Spacing. 

Ushbu ilova bizga tanish bo'lgan Paragraph palitrasini deyarli to'liq 

takrorlaydi (2.2.5-rasm). Xat boshi oldidan va keyin, chpdan va o‘ngdan joy 

tashlash Paragraph palitrasida yoki boshqaruv panelida bo'lgani kabi. Bu yerda 

abzats oldidan va keyin joy tashlash, ayniqsa, asosiy matn va sarlavha o'rtasidagi 

munosabatlarga nisbatan muhim ahamiyatga ega. Katta matnlar uchun 

abzatstslar va satrlar o‘rtadagi masofalar qiymati aynan ushbu stilda berilishi 

kerak, chunki keyin uni butun hujjat uchun o‘zgartirish oson bo‘ladi.  

 

2.2.5-rasm. Paragraph Style Options palitrasi. Indents and Spacing ilovasi. 

Izoh: Sarlavha stilida abzatslar oldidan va keyin joy tashlashning muhim xususiyati 

– sarlavha oldingi matndan ko‘ra, pastki matnga (ya'ni ochilgan kontentda) yaqin 

bo'lishini hisoblash kerak. Kolonkali nashrlarda eng ko‘p uchraydigan xato – bu 

sarlavhani matn bloklari o‘rtasida joylashtirish, bunda sarlavha o‘z matnidan 

butunlay uzilib qoladi va o‘qilishda juda chalkashtiradi.   

Align to Grid (To‘rga moslash) maydon alohida ahamiyatga ega: bu yerda 

siz matnning barcha satrlarni moslastirish qiymatlarini belgilashingiz va faqatgina 

birinchi satr uchun belgilashingiz yoki qiymatlarni bekor qilishingiz mumkin. 

Barcha satrlarni to‘r bo‘yicha moslastirish asosiy matn uchun ko‘llash lozim, faqat 

birinchi satr - boshqa shrift bilan (odatda kichkina) turli xil qo'shimchalar va 

sharhlarda: bunda qo‘shimchaning birinchi qatori shriftning asosiy satrlaridan 

birida joylashadi va uning qolgan satrlari bir-biriga yaqinroq joylashadi. Va 
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nihoyat, to‘rga mos kelmasligi - gazeta va jurnallarning sarlavhalar nashrlari uchun 

mos keladigan yechim, aks holda ular uchun  ajratilgan maydonga yomon 

joylashadi. 

Advanced Character Formats (Qo‘shimcha belgilar sozlamalari) ilovasida 

Language (til) maydonida Russian (Rus tili) ni tanlang. 

Indents and Spacing ilovasida Alignment  (Moslashtirish) = Left Justify 

(Chap tomonda), abzattsga joy tashlash (Xat boshi - First Line Indent) = 8 mm. 

Bu kitob satri uchun oqilona joy tashlash. Gazeta ustunida 5-6 mm ga teng bo'lardi. 

Barcha qatorlar uchun to‘r bo‘yicha moslashtirishni o'rnating (Align to Grid  

= All lines). 

Ko'rib chiqilgan ilovalar abzatsga shakl berish va uning ko'rinishini 

belgilash uchun asosiy parametrlarni o'z ichiga oladi. 

Endi maxsus sozlamalar haqida gap yuritamiz.  

 Tabs  (Tabulyatsiya chizig‘i). 

Tabulyatsiya chizig‘i (Tabs ) klaviaturada <Tab> tugmachasi bilan bog'liq. 

Matnni ma'lum bir gorizontal holatda freymda joylashtirish uchun 

foydalaniladi: <Tab> tugmachasini bosgandan so'ng, kursor tabulyatsiya 

chizig‘ida ko'rsatilgan belgiga o'tadi (6.6-rasm).  

 

2.2.6-rasm. Paragraph Style Options palitrasi. Tabs ilovasi. 

Tabulyatsiya chizig‘i ikki asosiy vazifani hal qilish uchun mo'ljallangan: 

jadvallarni yaratmasdan (masalan, ro'yxatlarda) matnlar ustunlarini tekislash va 

ko‘p nuqtalarni yaratish (bir nechta nuqta bilan satr elementlari orasidagi bo'shliqni 
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to'ldirish) uchun. Ko‘p nuqtalar ko'pincha mundarijani yaratish uchun ishlatiladi, 

shuning uchun stillar yaratilganda, qaysisi mundarijaning ko'rinishini 

shakllantiradi, Tabs ilovasi albatta ishlatiladi.  

Hujjatda matnning moslashtirish nuqtasini boshqarish uchun, tabulyatsiya 

chizig‘idan foydalanishingiz mumkin. Bu ro'yxat yoki jadvallar bilan ishlash uchun 

maxsus stil bo'ladi. 

Yangi moslashtirish nuqtasini o'rnatish uchun, markerni (o'lchagich ustidagi 

kichik qora strelkani) tanlang, u bilan o'lchagichning yuqori qismida bosing 

(o'lchagich qismlari ustidagi bo'sh oq maydon). Ko‘rsatgichning egilish 

yo'nalishiga qarab, u chap, o‘ng va markaz tomondagi pozitsiyasiga qarab matnni 

moslshtiradi. Ko‘rsatgichni o'rnatib, <Tab> tugmachasini bosgandan keyin 

kursorning pozitsiyasini aniqlaysiz. 

Ko‘p nuqtalarni yaratish uchun, o‘lchatgichda matnni moslashtiradigan 

o‘rnatilgan ko‘rsatgichni ajratish kerak va  faol ajratishda  Leader maydoniga 

nuqta qo'ying. Tanlangan nishondan oldingi bo'sh joy Leader maydoniga kiritilgan 

belgilar bilan to'ldiriladi. 

 Paragraph Rules (Xatboshi chiziqlari). 

Ushbu ilova (2.2.7-rasm) abzatsni chiziqlar bilan ajratish imkonini beradi: biri 

yuqoridan, ikkinchisi ostidan. Bu doimo bajarilmasligi kerak. Bunday usul, 

misol uchun, gazeta qo'shimchasiga juda mos bo'lishi mumkin, qaysisi boshqa 

xil matn bilan teriladi yoki boshqa nashriyot usuli bilan ajratiladi (6.7-rasm). 

 

2.2.7-rasm. Paragraph Style Options palitrasi. Paragraph Rules ilovasi. 
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Chiziq ko‘rsatuvi (Rule On) ni belgilash orqali ruxsat etiladi. 

Chiziqlarni ko'rsatishga ruxsat berib, ularning sozlamalaridan foydalana 

olasiz (barcha o'rnatish maydonchalari faol bo'ladi). Odatda, bu erda Stroke 

(Chiziq) palitrasi nazorat qiladi, hamda o'rnatilgan Swatches (Namunalar) ichki 

palitrasida rangni tanlash mumkin. Abzatts satrining muhim sozlamasi Offset - 

matndan chiziqgacha masofasidir (2.2.8-rasm). 

 

2.2.8-rasm. Abzats chiziqlarini ishlatish namunasi. 

Izoh: Shriftni konturga o‘tkazganda, qaysisi stillarida abzats chiziqlarini o'z ichiga 

olgan, uni ajratilishi matn Selection (Qora strelka) vositasi bilan emas, balki Type 

(Matn) vositasi bilan bo'lishi kerak. Bunday holda, chiziqlar matn bilan birga 

o‘zgaradi. Selection asbobini tanlaganingizda, chiziqlar yoqoladi.  

 Keep Options. Ushbu ilova (2.2.9-rasm) matndagi abzattslarning noto‘g‘ri 

ko'rinishini avtomatik ravishda oldini olish imkonini beradi. Misol uchun, 

sarlavha atagan matndan uzulib tursa, bunday ko‘rinish juda g'alati. Osilib turgan 

satrlar – bu maxsus muammo, abzatsning oxirgi satrlari keying betning boshida 

joylashishi yoki aksi –  keyingi abzatsning birinchi satri betning oxirida (2.2.10-

rasm). 
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2.2.9-rasm. Paragraph Style Options palitrasi. Keep Options ilovasi. 

 

2.2.10-rasm.  Nashr xatolari: sarlavhaning uzilishi, osilgan satrlar. 

Matnning muayyan qismiga ta'sir ko'rsatadigan sozlamalar (sarlavha, izoh, 

tananing matnlari va boshqalar) ushbu qism uchun stilda (sarlavha stili, izoh stili, 

asosiy matn stili) belgilanadi. 

Keep with Next maydoni sarlavhalarni asosiy matndan uzulishini oldini 

oladi. 

An'anaga ko'ra, sarlavhadan keyingi bo‘shliqda keying abzatsning kamida 

uchta satri joylashishi mumkin, aks holda o'qiyotgan paytda matn osilgan satrlarga 

o'xshaydi. Ko'pincha, maydonga 3 qiymati kiritiladi, ba'zan (masalan, p‘esani 

nashr etganda) u kamroq bo'lishi mumkin (ya'ni, bu qiymat 2ga teng; 1 qiymati 

ushbu maydonda qo‘llanilmaydi). Shu bilan birga, sarlavha va matnni uzulish 

imkoniyati yo‘qoladi. Ushbu parametr sarlavhani formatlash stilining bir qismi 

bo'lishi kerak. 

Keep with Next Together maydoni sarlavhaning asosiy matndan uzulishini 

nazorat qilish uchun ishlatiladi. U ishning ikkita rejimiga ega: All Lines in 

Paragraph (Abzatsni uzmaslik) va At Start/End of Paragraph (Osilgan 

satrlarning oldinini olish). Birinchi rejim (All Lines in Paragraph) bir abzatsning 

qismlarini turli betlarda joylashtirishini man etadi. Ushbu rejim rasmlarning 

nomini, ko‘p satrli sarlavhalarni yoki izohlarni yozishda ishlatiladi. Amalda bu 

degani: agar abzats to‘liq betga sig‘masa, bunda u to‘liq keyingi betga ko‘chiriladi. 

Ikkinchi rejim (At Start/End of Paragraph) osilgan satrlarni avtomatik tarzda 

yoqotadi. Biz faqat muvofiq maydonda abzatsning satrlar sonini ko‘rsatishimiz 
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kerak xolos. Satrlar soni albatta betning oxirida qolishi yoki keying betga o‘tishi 

kerak.  

Masalan, Start и End maydonlarining qiymatini 2-ga tenglashtirib, biz shu 

bilan o‘shani belgilaymizki, kamida ikkita qator ko‘chiriladi / saqlanadi.  

Ushbu usul orqali osilgan satrlarni oldini olish assimetrik ichki betlarning 

paydo bo‘lishiga olib kelishi mumkin: chap va o'ngdagi satrlar soni turli bo'lishi 

mumkin. Jurnallar va ba‘zi bir kitblar (masalan, ma'lumotnomalar) nashrlarida 

bunday ko'rinish bo‘lishi mumkin, ammo gazetalarda va klassik kitob nashrlarida 

bunisi mutlaqo bo‘lishi mumkin emas.  Bunday holda, osilgan satrlardan xalos 

bo‘lish kerak (masalan, har bir satrda belgilar sonini va so‘zlarni ko‘chirilishini 

qo‘yib chiqqan holda). 

Start Paragraph (Abzats boshi) - bu abzatsni oldingiga  ko'ra, qayerda 

boshlashni belgilovchi juda muhim parametr (2.2.11-rasm). Masalan, ro'yxatdagi 

On Next Page ni tanlab, abzats yangi sahifada boshlanishini, In Next Column ni 

–  keyingi kolonkada va hokazolarni belgilab qo'yasiz. Kitoblar bilan ishlashda bu 

parametrni ishlatish ayniqsa foydalidir, chunki odatda kitoblarning har bir bobi 

yangi sahifadan boshlanadi. 

 

2.2.11-rasm. Abzattsning boshlanish joylari ro‘yhati. 

 Hyphenation (So‘z ko‘chirishlarni qo‘yish) (2.2.12-rasm). 

Lug'atni to'g'ri tanlash bilan ham, so‘z ko‘chirishlarni qo‘yish oson emas va uni 

avtomatlashtirish qiyin. Kerakli moslashuvchanlikni ta'minlash va shu bilan 

birga maket ko'rinishini ko'p sonli ko‘chrishlar ketma-ketligi bilan  buzmaslik 
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kerak (so‘z ko‘chirish belgisi bilan yakunlangan satr kalta ko‘rinadi va shu 

kabi satrlar ko'p bo'lsa, hujjatning shu qismi o'ng tomondan surilganday 

ko‘rinadi). 

Hyphenation ilovasi so‘z ko‘chirish barcha sozlamalarini boshqarish imkonini 

beradi. Bu erda tanlangan tilda ko‘chirish qoidalarini belgilashingiz mumkin: 

ruxsat berilgan so‘z ko‘chrilishi ketma-ket kelish soni, ko‘chirish maydoni – 

satr qismining uzunligi, qaysisi ko‘chrish variantini tanlashda ko‘rilib chiqiladi 

va boshqalar. 

Avtomatik tarzda ko‘chirishni qo‘yib chiqish juda murakkab va ushbu 

ilovaning ehtiyotlik bilan qoyilgan barcha sozlamalari ham, barcha 

ko‘chirishlarni til jihatidan to'g'ri tarzda amalga oshirilish va hujjatning chiroyli 

ko'rinish kafolatini bermaydi. Tilda qabul qilingan til qoidalarini buzilishi va 

satr ko‘rinishi yomonlashishi (harflar yoki so'zlarning haddan tashqari zich 

joylashishi yoki aksincha, juda katta bo'shliqlar tufayli kamchiliklar bo'lishi 

mumkin) paydo bo‘lishi mumkin. Xatolar qo'lda tuzatilishi mumkin. 

Ko‘chrishni qo'lda o'rnatish uchun ihtiyoriy ko’chirish amallanadi, bunisi 

<Shift> + <-> tugmachalarini bosib amalga oshiriladi. Bu ko‘chrishning 

maxsus belgisidir va so‘zni ko‘chirish kerak bo‘lmagunicha ko'rinmasdir. Agar 

siz so'zning istalgan nuqtasida ixtiyoriy ko‘chirish belgisini qo'ysangiz, dastur 

mumkin bo'lsa ko‘chirishni bajaradi (agar ko‘chirishlar soni ruxsat 

berilganidan oshmasa, keyingi qatorlarni juda zichlamasa va hokazo).  

 

2.2.12-rasm. Paragraph Style Options palitrasi. Hyphenation ilovasi. 

 Justfication (O‘chirish sozlamalari). 
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O'chirish (Moslashtirish) – satrda so‘zlarni va belgilarni taqsimlash, matn 

bloklning bir yoki ikkala chetini bir vaqtning o'zida tekislash, yoki matn 

satrlarini vertical o‘qi bo‘yicha simmetrik tarzda joylashtirishga imkon beradi.  

Moslashtirish umumiy sozlama parametrlari stilning ustida ishlash dastlabki 

qismida, Indents and Spacing ilovasida o'rnatilgan edi va bu yerda satr 

ichidagi matnning xatti-harakatlarini tartibga soluvchi juda nozik sozlamalar 

bajariladi (2.2.13-rasm). 

 

2.2.13-rasm. Paragraph Style Options palitrasi. Justfication ilovasi. 

 

Ushbu sozlamalarning to'g'ri tanlovi, satrda so'zlarni va belgilarni juda zich va juda 

siyrak joylashuvini oldini olish imkonini beradi (6.14-rasm). 

 

2.2.14-rasm. Sifatli sozlama bo`lganda muammolar hosl bo`ladi 

Bu erda har bir parametr uchun uchta asosiy variant mavjud: 

 minimal qiymat (Minimum ); 

 istalgan qiymat (Desired) ; 

 mumkin bo'lgan maksimal qiymat (Maximum). 

Bundan tashqari, uchta asosiy parametr mavjud: 

 bo'shliqning kengligi (Word Spacing ) (prbelni bosish bilan olingan bo‘shliq); 
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 belgilarning orasidagi masofani o‘zgartirish (Letter Spacing) (kerning va 

trekking qo‘shilgan); 

 matnli belgilar nisbatlarini o'zgartirish (Glyph Scaling). 

Ushbu parametrlar ruxsat etilgan ko‘chirish qiymatlari bilan birgalikda, matnni 

optik jihatdan moslashtirilgan va o'qishda qulaylik imkonini beradi. 

 Bullets and Numbering (Raqamli va belgili (markerli) ro'yxatlar). 

Matnning bir qismini ro‘xat qilib chiqarish – turli matnli maketlar bilan ishlashda 

juda mashhur ish. Har bir ro'yxatni alohida vaqtni sarflab bezamaslik uchun, 

ro'yxat parametrlarini to'g'ridan-to'g'ri abzats stilida sozlash juda qulay (6.15-

rasm). Agar abzats stiliga bog‘lanmagan ro'yxat tuzishni istasangiz (masalan, 

butun nashrda faqat bitta ro'yxat mavjud), bunda Boshqarish panelida Bullets & 

Numbering buyrug'idan foydalanishingiz mumkin. 

 

2.2.15-rasm. Paragraph Style Options palitrasi. Bullets & Numbering ilovasi. 

 

List Type bosqichida ro'yxat turi tanlanadi: belgili yoki raqamlangan. 

Bunga qarab, oynada raqamlarning tashqi ko'rinishini sozlash yoki ro'yxat 

belgilarining sozlamalari ko'rsatiladi. 

Ro'yxat belgisi har qanday mavjud shriftning har qanday belgisi bo'lishi 

mumkin.  
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Yangi markerlarni qo'shish uchun marker jadvalining yonidagi Add 

(Qo'shish) tugmasini bosing, shrift va belgini tanlang, Add ni bosing.  

Character After (markerdan keyin belgi) maydoni markerning asosiy 

matndan qanday ajratilishini aniqlaydi. Odatda bu tabulyatsiya belgisi.  

Markerning nisbiy va asosiy matn joylashuvi.  Bu erda Left Indent 

(Chapdan bo‘shlik) —  asosiy matngacha bo'lgan masofa, First Line Indent 

(Abzat uchun bo‘shlik) — matnning chetidan markerni chapga chiqish qiymati.  

Oxirgi maydondagi qiymat manfiy bo'lishi mumkin, ammo (modulga ko'ra) chap 

bo‘shlikdan katta emas.  Ushbu bo‘shliklarning modullari teng bo'lsa, bunda Tab 

Position (Tabulyatsiya qiymati) maydoni faol bo'lmaydi.  Aks holda, tabulyatsiya 

qiymati quyidagi diapazonda ko‘rsatilishi mumkin: markernig chap tomondagi va 

asosiy matnning chap tomonidagi orasidagi qiymatidan markerning kenglik 

qiymati ajratiladi (2.2.16-rasm). 

 

2.2.16-rasm. Markerli ro`yxatda otstuplar 

Raqamli ro'yxat uchun, huddi belgili ro‘yhat uchun, raqamlash turi (Arab, 

Rim, harfli va boshqalar) va raqam va matnning o'zaro aniqlanadi.   

 Character Color (Matn rangi).  

Ushbu ilovada tanlangan uslub bilan bezatilgan abzatslar uchun matn rangi 

belgilanadi.  Uning sozlamalari sizga tanish bo'lgan Swatches palitrasiga 

(Namunalar)  juda o'xshash.  Bu erda siz nafaqat belgilarning rangini sozlashingiz, 

balki ularga obvodkani belgilashingiz va uning rangi va qalinligini belgilashingiz 

mumkin (2.2.17-rasm). 
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2.2.17-rasm. Pharagraph Style Options palitrasi. Character Color vkladkasi 

Biz bu erda ba'zi ilovalarni ko'rib chiqmadik — masalan, abzats ichidagi matnni 

ustunlarga bo'lish yoki matnning pastki chiziqlarini sozlash kabi, lekin bu 

sozlamalar murakkab emas va kamdan-kam hollarda qo'llaniladi, ularga murojaat 

qilish vaqtida siz o'zingizning harakatlaringizni tushunishingiz mumkin.  

Abzats uslubini to'liq sozlab, OK tugmasini bosing va belgilar stillarini ko'rib 

chiqamiz. 

Belgi stilini yaratish va qo’llash 

Belgi stili abzats stilidan farq qiladi, chunki u butun abzatsni boshqarishni 

talab qilmasdan, alohida belgilarga yoki ularning ketma-ketligiga qo‘llaniladi. 

Bunday cheklangan harakatini ta‘minlash uchun u alohida Character Styles (Belgi 

stillari) palitrasida sozlanadi va saqlanadi.  Huddi Paragraph Styles (Abzats 

stillari) palitrasida bo'lgani kabi, sozlamalar yangi stilni yaratish tugmasi yoki 

mavjud bo‘lgan stilning ustiga ikki marta bosish orqali chaqiriladi. Ushbu palitrada 

Paragraph Styles (Abzats stillari) palitrasida mavjud bo'lgan sozlamalarni qisman 

takrorlaydi — belgilarni formatlash bilan bog'liq bo'lganlari (2.2.18-rasm).  
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2.2.18-rasm. Character Style Options palitra. Basic Character Formats 

vkladka. 

Basic Character Formats (Belgilarning asosiy sozlamalari) ilovani ishlatib, 

main_text belgilar stilini yarating: 

 Font Family  =  Minion Pro;  

 Font Style  = Regular; 

 Size  = 10 pt;  

 Leading  = 12 pt; 

 Kerning  = Optical; 

 Tracking  = 0.  

Ichki uslublar va bosh harflar Harflar (bosh harf) – ushbu vosita orqali siz 

matnning boshini bezaysiz. Bu uslub avvaldan amallangan, matn o‘quvchining 

e‘tiborini qaratish uchun, ba‘zan bosh harfning ichida rasm ham chizilib qo‘yilgan 

bo‘lar edi.  

Adobe InDesign-da bosh harflarni yaratish va sozlash Paragraph Styles 

palitrasining Drop Caps and Nested Styles ilovasida (Bosh harflar va ichki stillar) 

bajariladi (2.2.19-rasm).  

 

2.2.19-rasm Vkladka Drop Caps and Nested Styles palitralar Paragraph 

Styles. 

Bosh harf bir abzatsning atributi bo'lishi ham mumkin va keyin uni 

Boshqarish panelida sozlash kerak bo‘ladi, lekin "Bobning birinchi abzatsi" stilini 

yaratish va uni ushbu turdagi barcha abzatslarga qo'llash oqilona.  
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Biz bilganimizdek, bosh harf ikkita parametr bilan tavsiflanadi: satrdagi 

balandlik va harfga kiritiladigan belgilar soni. Bosh harfni belgi stili bilan bezatish 

mumkin (bu holda, "Bosh harf" stili birinchi navbatda Character Styles (Belgilar 

stili) palitrasida yaratilishi kerak — masalan, bosh  harf uchun ba'zi bir aktsident 

shrift tanlash, nostandart naqshni o'rnatish va h.k.).  

Bosh harfning kattaligi maydonlarida bosh harfning balandligi satrlarda va 

bosh harf deb hisoblangan belgilar soni belgilanadi.  

Izoh: Yahshisi bosh harfning kengligi 1ga teng bo'lishi kerak, chunki bunda 

bosh harf bitta bo‘ladi. Agar birinchi so'zni turlicha bezatish kerak bo'lsa, (Nested 

Style) ichki stili bilan foydalanish lozim.  

Nested Style (ichki stil) doirasida belgi stili aniqlanadi, bu belgi stilida 

matnning dastlabki bir necha harflar yoki so'zlar yoziladi, xuddiki bosh harfdan 

qolgan matnga o'tishni nazarda tutadi.  Tabiiyki, bu stilni ham Character Styles 

(Abzats stillari) palitrasida oldindan tayyorlanishi kerak.  

Ichki uslubni sozlash quyidagicha:  

1.  Stillar ochiladigan ro'yxatidan ushbu maqsad uchun yaratilgan stil tanlanadi. 

2.  Stilni qo'llash usuli aniqlanadi – Up To (Gacha qo‘llash...) yoki Through  

(Unga qo'llash...) va uni qo'llash sohasi – belgilar, so'zlar yoki to'plamning boshqa 

elementlari soni (6.20-rasm).  

 

2.2.20-rasm.  Ichki stilni qo'llash sohasini tanlash. 

 Nested Line Styles (Ichki stillar satri) maydoni bir yoki bir nechta satr 

uchun ichki uslubni o'rnatish imkonini beradi. Bu erda sozlamalar Nested Style 
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maydoniga o'xshaydi va faqat qo‘llash sohasida farq qiladi: bu erda faqat qatorlar 

soni ko'rsatilishi mumkin.  

Bizning ish matnimiz uchun "Birinchi abzats" stilini yarataylik.  

1. Character Styles palitrasida main_text stili asosida, uning ichida Minion Pro 

garniturasini Impact bilan almashtirib, Initial stilini yarating.  

2.  O‘sha joyda, main_text stiliga asoslangan First_word stilini yarating, Case 

(Registr) maydonida Small Caps qiymatini bering.  

3.  Paragraf Styles (Abzats stillari) palitrasida main stiliga asoslangan 

First_paragraph stilini yarating.  

4.  Drop Caps and Nested Styles (Bosh harflar va ichki uslublar) ilovani oching. 

5.  Bosh harf parametrlarini belgilang: 

 Lines = 3;  

 Characters = 1;  

 Character Styles = Initial.  

6.  Ichki stilning parametrlarini belgilang:  

 Character Styles = First_word ni Through, 2, Words rejimida amallash. 

Bizning ichki stilimis abzatsning birinchi ikki so'ziga beriladi.  

7. Matnimizning birinchi abzatsiga First_paragraph stilini qo'llang (2.2.21-rasm).  

 

2.2.21-rasm. Bosh hafr bilan va ichki stil bilan stilni ishlatish misoli. 

Stillarni tahrirlash 

Stillarni tahrirlashini chaqirish uchun Paragraph Styles palitrasida yoki 

Character Styles palitrasida uning satriga ikki marta bosish kifoya va bizga tanish 
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bo'lgan stillar sozlamalari oynasi paydo bo'ladi.  Stilni istalgan vaqtda 

o'zgartirishingiz mumkin va barcha o'zgarishlar ushbu stil bilan formatlangan 

barcha matn qismlariga darhol qo'llaniladi. 

Boshqa hujjatdan stillarni yuklab olish  

Stillar to'plamini boshqa hujjatlardan yuklab olishingiz mumkin, buning 

uchun Load Character/Paragraph Styles (Belgilar stilini yuklash / Abzats stilini 

yuklash) buyrug'ini bajaring. Ushbu palitralarning har ikkalasi ham kontekst 

menyusida barcha abzats va belgilar stillarini birgalikga o‘rnatish imkonini 

beradigan Load All Texst Styles (Barcha stillarni yuklab olish) buyrug‘ini o‘z 

ichiga oladi.  Ushbu buyruq ayniqsa katta loyihalar bilan ishlashda juda foydalidir 

(bir nechta alohida hujjatlardan tashkil topgan kitoblar: bir marta stillar to'plamini 

yaratishga imkon beradi va keyin uni yangi hujjatlarga faqat yuklaydi xolos).  

Standart boshqarish oynasida kerakli stillar bilan faylni tanlagandan so'ng, 

muloqot oynasi ochiladi bu erda siz ish hujjatida kerakli stillarni tanlaysiz (2.2.22-

rasm).  

 

2.2.22-rasm. Stilni yuklash muloqot oynasida stillarni tanlash. 

 Stillar ro'yxatida ajratilgan stil uchun oynaning pastki maydonida uning 

barcha sozlamalarining tavsifi paydo bo'ladi. Faqat kerakli stillarni ajratib, OK ni 

bosing.  Stillar tegishli palitralarga qo'shiladi. [2] 

 

2.3. Kitoblar va kutubxonalar 

Kitob bog'langan hujjatlar tizimi sifatida  
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Kitob fayli – bu bir xil uslublar, namunalar, shablon-sahifalar va boshqa 

elementlardan iborat  bo'lgan hujjatlar to'plamidir. Kitobning hujjatlarida 

sahifalarni raqamlash, kitobning alohida hujjatlarini chop etish yoki ularni PDF-

fayllarga eksport qilish mumkin. Bitta hujjat bir nechta kitoblarga tegishli bo'lishi 

mumkin.  Shunday qilib, siz nisbatan kichik hujjat bilan bir vaqtning o'zida 

ishlashingiz va uni kitobning boshqaruv vositalaridan foydalanib, loyihaning 

barcha boshqa qismlariga muvofiqligini nazorat qilishingiz mumkin. 

Kitob fayliga qo'shilgan hujjatlardan biri stillar manbai bo'lib qoladi. Odatiy 

bo'lib, stillar manbai kitobdagi birinchi hujjatdir, lekin har qanday vaqtda kitobning 

barcha qismlarini formatlash va o'zaro bog‘liklikni ta'minlaydigan yangi stillar 

manbasini tanlash mumkin.  

Ushbu jarayonni ikki bobdan iborat kitob misolida ko'rib chiqamiz.  

1.Quyidagi sozlamalr bilan hujjat yarating: 

 Print;  

 Size = A5;  

 Nambers of Columns = 1;  

 Margins:  

 Inside = 12 mm;  

 Top = 16 mm;  

 Outside = 20 mm;  

 Bottom = 24 mm. 

2. Sahifa raqamlari va kolontitullar bilan oddiy shablonni yarating: "Pelam 

Grenville Woodhouse. Blanding Saga" va "Section" (Suzuvchi kolontitul).  

3. Ikkita uslubini yarating: Body (Asosiy matn uchun) va Header (sarlavhalar 

uchun).  

4. Birinchi sahifada Numbering & Section Options sozlamani qo'llang; "1-bob. 

Qovoq qo'riqchisi" degan joyda bo'limning markerini o'rnating. 

5. Blandings.indd nomi bilan faylni shablon sifatida saqlang (Save As > InDesign 

Template).  

6.  Lord_emsworth faylni.doc import qiling. 
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7.  Matnni joylashtiring va formatlang.  

8.  Glava.indd deb nomlangan hujjat sifatida faylni saqlang.  

9.  Shablon asosida yangi hujjat yarating. Barcha master-shablonlar va uslublar 

avtomatik ravishda shablondan unga o'tkaziladi.  

10.  Bo'limning markerini "2-bob. Svi-ou-ou-hey!" deb almashtiring.   

11.  Pi-i-ggy.doc faylini import qiling.  

12.  Matnni joylashtiring va formatlang.  

13.  Faylni 2-bob.indd nomi bilan saqlang.  

14.  Endi siz kitobni yig'ishni boshlasangiz bo‘ladi.  

15.  Menyudan Fayl > New > Book (Fayl > Yangi > Kitob)ni tanlang. 

16.  Kitobning nomini kiriting — masalan, Blandings. Saqlash tugmasini bosing. 

17.  Book (Kitob) palitrasi  paydo bo'ladi (2.3.1-rasm). Kitob fayli indb 

kengaytmasi bilan saqlanadi. 

 

2.3.1-rasm. Book palitrasi. 

Kitob fayliga hujjatlarni qo'shish  

Book (Kitob) palitrasi — hujjatlarni qo'shish, o'chirish yoki tartibga solish 

mumkin bo'lgan kitob faylining ish maydoni.  

1.  Palitraning pastki qismidagi " + "  tugmani bosing.  

2.  Ikkala hujjatni (1-bob va 2-bob) tanlang va Open tugmasini bosing.  

3. Hujjatni stillar manbai sifatida e'lon qilish uchun palitrada hujjatning nomi 

yonidagi katakchada bayroqchani qo‘ying.  

Savol tug'iladi: nima uchun hujjatni stillar manbasi deb e‘lon qilamiz, agarda 

yangi hujjat asl hujjatning barcha sozlamalarini saqlaydigan shablon asosida 

yaratilsa? Yangi hujjatlarda ishlash jarayonida dastlabkisi bilan farqlar paydo 

bo'lishi mumkin — yangi stillar, yangi shablonlar, oldindan yaratilgan 

shablonlardagi o'zgarishlar va boshqalar. Kitobning barcha qismlarini bitta turga 
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olib kelish uchun, moslashtirish (sinxronlash) vazifasidan foydalaniladi. Ushbu 

vazifa sozlamalar to‘plamiga asoslangan bo‘lib, uslublar manbai deb e'lon 

qilingan.  

Book (Kitob) palitrasidagi hujjat satrida ikki marta bosilganda, u tahrirlash 

uchun ochadi (2.3.2-rasm).  

 

2.3.2-rasm. Qo‘shilgan hujjtlar bilan Book palitrasi. 

Kitob fayllarini boshqarish  

Kitobning har bir ochilgan fayli Book (Kitob) palitrasi alohida ilovasida  

paydo bo'ladi. Agar bir vaqtning o'zida bir nechta kitob ochilgan bo‘lsa, ushbu 

kitobga o'tish va kerakli palitraning menyusiga kirish uchun tegishli ilovani bosing.  

Book (Kitob) palitrasidagi belgilar hujjatning joriy holatini ko'rsatadi: ochiq, 

yo'q (ko'chirilgan, qayta nomlangan yoki o'chirilgan), o'zgartirilgan (tahrirlangan 

yoki hujjat yopilganda sahifa yoki bo'limlarning raqamlari o'zgargan) yoki 

ishlatilayapti (hujjat ish jarayonida boshqa foydalanuvchi tomonidan ochilgan).  

Yopiq hujjatlar yonida belgilar ko'rsatilmaydi. 

Kitob faylini saqlash  

Kitob fayllari hujjat fayllaridan alohida saqlanadi. Agar Save Book (Kitobni 

saqlash) buyrug'ini tanlasangiz, InDesign kitobdagi hujjatlarni emas, balki 

kitobdagi o'zgarishlarni saqlaydi.  

Kitobni yangi nom bilan saqlash uchun Book (Kitob) palitrasi menyusidan 

Save Book as buyrug'i tanlanadi. 

Kitobni joriy nomi bilan saqlash uchun Book (Kitob) palitrasi menyusida 

Save Book (Kitobni saqlash) buyrug'i yoki Book (Kitob) palitrasining pastki 

qismida Save tugmasi tanlanadi.  
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Kitobdan hujjatlarni olib tashlash  

Hujjatni kitobdan olib tashlashilishi hujjatning kontekst menyusidagi 

Remove Document yoki palitraning pastki qismidagi "-" tugmasi bilan amalga 

oshiriladi. Hujjatni kitobdan olib tashlashi faylni diskdan olib tashlashni 

anglatmaydi, faqat kitob faylidan hujjatga havola o'chiriladi.  

Hujjatlarni kitobda moslashtirish (sinxronlashtirish).  

Kitobdagi hujjatlarni sinxronizatsiya qilish vaqtida berilgan elementlar 

(stillar, master-shablonlar, raqamli ro'yxatlar, namunalar va boshqalar) stillar 

manbasidan kitobda ko'rsatilgan hujjatlarga nusxalanadi, bunda bir xil nomli 

elementlar nusxalanganlar bilan almashtiradi.  

Agar stillar manbasida mavjud bo'lgan elementlar sinxronlashtirilgan 

hujjatlarda topilmasa, ular qo'shiladi.  Stillar manbasida ba'zi elementlar mavjud 

bo'lmasa, sinxronlangan hujjatlardagi tegishli elementlar o'zgarishsiz qoladi. 

Sinxronlash uchun elementlarni tanlash   

1.  Book (Kitob) palitrasi menyusida Synchronize Options (Sinxronlash 

parametrlari) buyrug;ini tanlang (2.3.3-rasm).  

2.  Stillar manbasidan kitobning boshqa hujjatlariga nusxa ko'chirishingiz kerak 

bo'lgan elementlarni tanlang — masalan, abzats stillari va master-shablonlar. 

 

2.3.3-rasm. Synchronize Options muloqot oynasi. 

Hujjatlarni kitob fayliga sinxronlashtirish  

Kitobni unga kiritilgan hujjatlarni ochmasdan sinxronlashtirishingiz 

mumkin.  InDesign dasturi yopiq hujjatlarni ochadi, o'zgarishlarni amalga oshiradi 

va keyin ularni saqlaydi va yopadi.  Sinxronlashtirish paytida ochilgan hujjatlar 

o'zgaradi, lekin saqlanmaydi.  
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1.  Book (Kitob) palitrasida 1-bob hujjatining yonidagi katakchaga bayroqchani 

qo‘ying.  

2.  Stillar manbasidan nusxasi ko'chirilishi kerak bo'lgan elmentlar Synchronize 

Options (Sinxronlash imkoniyatlari) dialog oynasida tanlanganligiga ishonch hosil 

qiling.  

3.  Stillar manbasi bolgan hujjat bilan sinxronlash kerak bo'lgan hujjatlarni tanlang. 

Agar hujjatlar tanlanmagan bo'lsa, butun kitob sinxronlashtiriladi.  

4. Book (Kitob) palitrasi menyusida Synchronize Book buyrug'ini tanlang yoki 

Book palitrasining pastki qismidagi Synchronize tugmasini bosing.  

 

Master-shablonlarni sinxronlash  

Master-shablonlar huddi boshqa elementlar kabi sinxronlashtiriladi: stillar 

manbaidagi bir xil nomlangan master-shablonlar (masalan, A-Master) 

almashtiriladi. Shablonlarni sinxronlash, bir xil bezak elementlarini ishlatadigan 

hujjatlar uchun qulaydir, masalan, ustunlar va kolontitullar.  

Master-shablonlarni faqat bitta stillar manbasidan sinxronlashtirish to'g'ri.  

Turli xil stillar manbasidan sinxronlashtirilganda, master-shablonining 

o'zgartirilgan elementlari shablon bilan aloqansini yo'qotishi mumkin.   

Kitobdagi sahifalar, boblar va abzatslarni raqamlash  

Kitobdagi sahifalar, boblar va abzatslarni ketma-ket raqamlashini sozlash 

uchun Book Page Numbering Options (Ketma-ket raqamlash parametrlari) va 

Update Numbering (Raqamlashni yangilash) buyruqlari mavjud.  

Sahifalar diapazoni Book (Kitob) palitrasida har bir hujjatning nomi oldida 

ko'rsatiladi.  Odatiy bo'lib, InDesign kitobning hujjatlaridagi sahifalarni qo'shish 

yoki o'chirishda, shuningdek, hujjatlarni qayta tartibga solish, hujjatlarni qo'shish 

yoki o'chirish kabi kitob fayliga o'zgartirishlar kiritishda sahifalar va bo'limlarning 

raqamlashini yangilaydi (2.3.4-rasm). Avtomatik tarzidagi sahifa va bo'limlar 

raqamlashini yangilash parametrini o'chirib, kitobdagi raqamlashni qo'lda 

yangilashingiz mumkin. 
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2.3.4-rasm.Book palitrasidagi sahifalar raqamlanishi. 

Agar hujjat mavjud bo'lmasa yoki ochilmasa, sahifa diapazoni o'rniga savol 

belgisi ko'rsatiladi "?" yo'qolgan hujjat bo'lishi kerak bo'lgan joydan, kitobning 

oxirigacha. Bu shuni anglatadiki, haqiqiy sahifalar diapazoni noma'lum. 

Raqamlashni yangilashdan oldin, yo'qolgan hujjatni o'chirish yoki almashtirish 

kerak. Hujjatning nomi yonidagi "Ishlatilayapti" belgisi, hujjat ish jarayonida 

boshqa foydalanuvchi tomonidan ochilganligini ko'rsatadi; raqamlashni yangilash 

uchun ushbu foydalanuvchi hujjatni yopishi kerak.  

Toq va juft sahifadan boshlab raqamlash  

Har bir hujjatda sahifalarni raqamlash tok va juft sahifadan boshlash 

mumkin. Buni Book (Kitob) palitrasining menyusidagi Book Page Numbering 

Options (Ketma-ket raqamlash parametrlari) buyrug‘i yordamida amalga 

oshiramiz (2.3.5-rasm).  

 

2.3.5-rasm. Book Page Numbering Options muloqot oynasi. 

Bu erda raqamlash ketma-ket amalga oshiriladimi yoki har doim tok yoki 

juft sahifalardan boshlanganligini tanlashingiz mumkin. 

Kitoblarda abzatslarning ketma-ket raqamlanishidan foydalanish  

Rasmlar, jadvallar yoki boshqa elementlarning ro'yxatlari uchun ketma-ket 

raqamlashni ishlatish uchun, avval abzats stilida ishlatiladigan raqamli ro'yxatni 

aniqlash kerak.  Raqamli ro'yxatining aniqlanilishi, kitobning barcha hujjatlari 

bo'yicha abzatslarning ketma-ket raqamlanishi bog‘liq.   
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Buning uchun quyidagi kerak bo‘ladi:  

1.  Kitob uchun stillar manbai sifatida ishlatiladigan hujjatni oching.  

2. Type  >  Bulleted  &  Numbered  Lists  >  Define  Lists  (Matn  > Raqamli va 

belgili ro‘yhatlar > Ro‘yhatlarni aniqlash) buyruqni chaqiring.   

3.  Yangisini ro‘yhatni o'rnatish yoki mavjud ro'yxatini tahrir qilish.  

4.  Bir vaqtning o'zida Continue  Numbers  Across  Stories  (Raqamlashni 

materiallar orasida davom etish)  va  Continue  Numbers  from  Previous 

Document in a Book (Kitobdagi avvalgi hujjatdan davom eting).  

5.  Raqamlangan ro'yxatni ishlatadigan abzats stilini belgilang va uni har bir 

hujjatda tegishli matnga qo'llang.  

Ro'yxatlar va abzatslar sozlamalarini sinxronlashtirish uchun Synchronise 

Options (Sinxronizatsiya parametrlari) dialog oynasida tegishli parametrlarni 

tanlashingiz va kitobni sinxronlashtirishingiz kerak.  

Kitobni chop etish yoki faylini chiqarish  

Kitob faylidan foydalanishning afzalliklaridan biri – bu tanlangan kitob 

hujjatlarini yoki butun kitobni chiqarish uchun bitta buyruqdan foydalanish 

qobiliyatidir.  

Buni amalga oshirish uchun Book (Kitob) palitrasi kontekst menyusidan 

Print Book (Kitobni chop etish) buyrug‘ini tanlang yoki palitrada kerakli 

hujjatlarni tanlab, Print Selected Documents (Tanlangan hujjatlarni chop etish) 

buyrug'ini tanlang.  

Mundarijani yaratish  

Mundarija jadvali kitob, jurnal yoki boshqa nashrning mundarijasini o'z 

ichiga oladi, hamda u illyustratsiyalar, reklama beruvchilar yoki fotosurat 

mualliflari ro'yxatini ko'rsatishi mumkin, nashr o'quvchisiga hujjat yoki kitobda 

kerakli ma'lumotlarni topishga yordam beradigan ma'lumotlarni o'z ichiga olishi 

mumkin.  Birta kitobning ichida bir nechta mundarijalar bo'lishi mumkin, masalan, 

boblar ro'yxati va rasmlarning ro'yxati.  

Har bir mundarija – bu alohida material bo‘lib, sarlavha va elementlar  

raqamlar yoki alifbo bo‘yicha tartiblangan ro'yxatidan iborat.  Mundarija 
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elementlari, shu jumladan, sahifa raqamlari ham to'g'ridan-to'g'ri hujjat 

mazmunidan olinadi va istalgan vaqtda yangilanishi mumkin.  

Mundarijani yaratish uchun siz uchta asosiy qadamni bajarishingiz kerak:  

1.  Mundarijani yaratish uchun asos bo'ladigan abzatslar stillarni yaratish va 

qo'llash.  

2. Qaysi (qanday uslub bilan bezatilgan) abzatslar mundarijaga kiritilganligini va 

mundarijani formatlash uchun stillarni belgilang.  

3.  Mundarijani hujjatga qo'shing. 

Izoh: Mundarijani tuzganda quyidagilar muhim: 

 mundarija stillarini boshqa hujjatlardan yoki kitoblardan yuklash mumkin, 

bunda yaratilgan yangi mundarija huddi shunday parametrlarga va formatlashga 

ega bo'ladi  (agar hujjatning abzats stilining nomlari manba hujjatining nomlari 

bilan mos kelmasa, import qilingan mundarijani o'zgartirish kerak bo'lishi 

mumkin);  

 mundarijani formatlash uchun, sarlavha va mundarija elementlari uchun, shu 

jumladan ham tabulyatsiya va prefikslar uchun abzats stillarini yaratish kerak;   

 sahifa raqamlari va belgilar uchun stil yratish mumkin, qaysisi sahifa 

raqamlarini mundarija elementlaridan ajratib turadi. Misol uchun, agar kerak 

bo'lsa, sahifa raqamlari qalin yozuvida bo'lishi uchun, Semibold (Qalin) 

atributini o'z ichiga olgan belgilar stilini yaratishingiz va mundarijani yaratishda 

sahifa raqamlari uchun ushbu belgilar stilini tanlashingiz kerak bo‘ladi. 

Kitob yoki hujjatning mundarijasini yaratishdan oldin uni tayyorlash kerak:  

1.  Kitobdagi hujjatlar ro'yxati to'liq ekanligiga ishonch hosil qiling, barcha 

hujjatlar to'g'ri tartibda ro'yxatga olinadi, barcha sarlavhalar to'g'ri stilda 

formatlanadi.  

2.  Abzats stillari butun kitobda bir xil ekanligiga ishonch hosil qiling: bir xil 

nomlarga va turli paramertrlarga ega bo'lgan stillar bilan hujjatlarni yaratmang, aks 

holda, stillar to'qnashuvi paydo bo'lishi mumkin va joriy stilning turidan 

foydalaniladi – bunisi sizning fikringiz ebo‘lmasligi mumkin.  
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3.  Barcha stillar kitobning barcha hujjatlarda mavjudligiga ishonch hosil qilish 

uchun, kitobni sinxronlashtiring. 

Mundarijani yaratish  

1. Avvalo, mundarijaga kiradigan abzatslarning stillarini aniqlang (sarlavhalar, 

kichik sarlavhalar va boshqalar) va ularning stillari kitobning barcha hujjatlarida 

bir xil bo'lishini tekshiring. Bizning misolimizda, bu Header stili.  

2. 1-bob hujjatining boshiga yoki 2-bob hujjatining oxiriga mundarija uchun 

sahifani qo'shing. Odatda bu "Mundarija "deb ataladi.  

3.  Layout > Table of Contents (Maket > Mundarija) buyrug‘ini  chaqiring (2.3.6-

rasm). 

 

2.3.6-rasm. Layout>Table of Contents muloqot oynasi. 

Agar mundarija stili aniqlangan bo'lsa, uni TOC Style (Mundarija stili) 

ro'yxatida tanlash mumkin.  

Title (Sarlavha) — mundarija sarlavhasi (Masalan, "Mundarija" yoki 

"Rasimlar ro'yxati"). Uni formatlash uchun Style (Stil) ro'yxatidagi stilni tanlang -

albatta, stil oldindan yaratilgan bo‘lishi kerak.  

Kitobdagi barcha hujjatlar uchun bitta mundarijani yaratish uchun Include 

Book Documents (Kitob hujjatlarini qo‘shish) maydonida bayroqchani qo‘ying.  

Styles TOC (Mundarijadagi stillar) maydonning o'ng tomonidagi ro'yxatdan 

kerakli stillarni chap tomonga qo'shish bilan mundarija belgilanadi.  

Tabiiyki, mundarijaning elementlari, ularni shakllantiradigan sarlavhalardan 

qo‘ra farqli ravishda shakllantirilishi kerak. Odatda, mundarijani formatlash stili 

asosiy matn stiliga asoslanadi, ammo kitobning umumiy stili imkon bersa, 
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dastlabki sarlavhalarga asoslangan bo'lishi mumkin.  Bunday holda, mundarijaning 

turli sathlari dastlabki sarlavhalardan va bir-biridan, birinchi navbatda, kegl va 

yozilishi bilan farq qiladi.  Mundarijaning har bir ichki elementi uchun, stil Entry 

Style (Element stili) ro'yxatidan tanlanadi. Bu erda ham sahifa raqami 

mundarijaning elementiga qo‘ra (ko'pincha keyin) joylashishi va qaysi belgi matn 

va raqam o'rtasidagi bo'shliqni (odatda tabulyatsiya) to'ldirishi aniqlanadi. Bu erda 

mundarijaning ichki elementlari stilida, tabulyatsiyani ko‘p nuqta qilib qo‘yish 

juda foydali, buning uchun Paragraph Styles (Abzats stili) palitrasida Tab 

ilovaning Leader maydonida "nuqta"ni kiriting. Agar kerak bo'lsa, oldindan 

yaratilgan ko‘p nuqtalar va sahifa raqamlari uchun stillarni belgilashingiz mumkin 

— masalan, ularni qalin yoki boshqa rangli qilib yozish.  

OK tugmasini bosgandan so'ng, yuklangan matnning kursori paydo bo'ladi. 

Kerakli sahifada sichqonchaning tugmasini bosish bilan mundarija o‘zining 

freymida joylashtiriladi. 

Izoh: Iloji bo'lsa, mundarijaning freymini hujjatdagi boshqa freymlar bilan 

bog'lamang. Mavjud mundarijani almashtirishda barcha materiallar yangilangan 

mundarija bilan almashtiriladi. 

Bir nechta ro'yxatlar uchun mundarijani yaratish  

Mundarijaning sozlamalari har bir to'plami mundarija stili sifatida saqlanishi 

mumkin va hujjat yoki kitobda turli mundarijalar uchun kerak bo'lsa, ishlatilishi 

mumkin. Misol uchun, mundarija uchun bir stilni, ikkinchisini esa suratlar yoki 

fotosuratlar mualliflari ro'yxati uchun ishlatishingiz mumkin. Mundarija stilini 

yaratish uchun, barcha parametrlarni sozlashning oxirida Save Style (Stilni 

saqlash) tugmasini bosing va stil nomini bering.  

Boshqa hujjatdan mundarija stillarni import qilish  

Boshqa hujjatlardan tayyor stillar Layout>Contents Styles Table (Maket> 

Mundarija stillari) dialog oynasining Load (Yuklab olish) tugmasini bosish bilan 

import qilinadi (2.3.7-rasm). 
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2.3.7-rasm. Layout>Contents Styles Table dialog oynasi. 

Mundarijani yangilash va tahrirlash  

Mundarija – bu hujjatning mazmuning "rasmi" desak bo‘ladi. Hujjatda 

sahifa raqamlari, sarlavhalar yoki mundarija elementlari bilan bog'liq boshqa 

narsalar o'zgargan bo'lsa, uni yangilash kerak, bunisi Layout > Update TOC 

(Maket > Mundarijani yangilash) buyrug‘i bilan bajarladi.  

Mundarijani o'zgartirish ma'nosiz, chunki u tezda shakllanadi va faqat hujjat 

(kitob) va faqat  uning sozlamalarini aks ettiradi.   

Mundarija sarlavhasini formatlashini, mundarija elementlarini yoki sahifa 

raqamlarini o'zgartirish uchun, ular bilan bog‘liq bo‘lgan abzatslar stillarini  yoki 

belgilarini o'zgartirishi kerak; sahifa raqamini o'zgartirish uchun (masalan, 1, 2, 3 

yoki i, ii, iii) kitobning hujjatlariga tegishli o'zgartirishlar kiritiladi.  

Har bir mundarija alohida yangilanadi.[2] 

 

Xulosa 

II bobda ko’p sahifali hujjat, stillar yaratish va undan foydalanish, kitoblar va 

kutubxonalar haqida ma’lumotlar keltirilgan.Bob bo’yicha keltirib o’tilgan 

ma’lumotlarning natijasi asosida qilingan amaliy ishlar nashriyot jarayonining 

ishlarini osonlashtirish uchun xizmat qiladi.  
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XOTIMA 

Bitiruv malakaviy ishning I bobida Adobe InDesign dasturi bilan tanishish, 

obyektlar, geometrik figuralar, matnlar bilan ishlash bo’yicha ma’lumotlar 

keltirilgan. Har bir bo’limning imkoniyatlari keng va batafsil tushuntirib berilgan. 

Har bir bo’limda tushuntirilgan nazariyalar rasmlar asosida yanada tushunarli qilib 

keltirib o’tilgan. 

II bobda ko’p sahifali hujjat, stillar yaratish va undan foydalanish, kitoblar va 

kutubxonalar haqida ma’lumotlar keltirilgan.Bob bo’yicha keltirib o’tilgan 

ma’lumotlarning natijasi asosida qilingan amaliy ishlar nashriyot jarayonining 

ishlarini osonlashtirish uchun xizmat qiladi. 
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